PowerLite® 1705c/1715c Multimedia Projector

User’s Guide
Important Safety Information

WARNING: Never look into the projector lens when the lamp is turned on; the bright light can damage your eyes. Never let children look into the lens when it is on. Never open any cover on the projector, except the lamp and filter covers. Dangerous electrical voltages inside the projector can severely injure you. Except as specifically explained in this User's Guide, do not attempt to service this product yourself. Refer all servicing to qualified service personnel.

WARNING: The projector and its accessories come packaged in plastic bags. Keep plastic bags away from small children to avoid any risk of suffocation.

Caution: When you replace the lamp, never touch the new lamp with your bare hands; the invisible residue left by the oil on your hands may shorten the lamp life. Use a cloth or glove to handle the new lamp.

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Trademarks

Epson and Instant Off are registered trademarks, and Epson Exceed Your Vision and EasyMP are trademarks of Seiko Epson Corporation.

PowerLite and PrivateLine are registered trademarks; SizeWise is a trademark; and Epson Connection, Epson Store, and Epson Extra Care are service marks of Epson America, Inc.

Pixelworks, DNX, and the DNX logo are trademarks of Pixelworks, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.
Contents

Welcome ......................................................... 9
Using Your Documentation ............................... 10
  Getting More Information ............................ 10
Registration and Warranty .............................. 11
Unpacking the Projector ................................. 12
  Additional Components ............................... 13
  Optional Accessories ................................. 13

1 Displaying and Adjusting the Image ............... 15
Positioning the Projector ............................... 16
Projecting the Image ...................................... 17
  Turning On the Projector ......................... 17
  Selecting the Image Source ....................... 19
Troubleshooting Display Problems ................... 20
  You Can’t Project an Image ....................... 20
  The Projector and Notebook Don’t Display the
    Same Image ....................................... 20
Adjusting the Image ...................................... 22
  Adjusting the Height of Your Image ............ 22
  Focusing and Zooming Your Image .............. 23
  Adjusting the Image Shape ....................... 23
  Correcting Computer Images ..................... 25
  Using the A/V Mute Slide ......................... 25
Shutting Down the Projector ......................... 25
  Using the Direct Power On Function ............ 26
2 Using the Remote Control

Using the Remote Control ........................................... 27
Replacing the Batteries .................................................. 28
Controlling the Picture and Sound ................................. 29
Switching Between Picture Sources ............................... 29
Turning Off the Picture and Sound ................................. 30
Stopping Action ............................................................. 30
Zooming Part of Your Image .......................................... 31
Controlling the Volume ................................................... 31
Resizing Video Images .................................................... 32
Adjusting the Color Mode ............................................... 32
Operating Your Computer with the Remote Control ......... 33
Highlighting Your Presentation ....................................... 34
Using the Pointer Tool .................................................... 34
Customizing the Pointer Tool ........................................... 34

3 Connecting to Computers, Cameras, and Other Equipment

Connecting to a Computer ............................................. 35
Connecting to the Computer Port .................................... 36
Connecting to the USB Port ............................................. 37
Connecting the Cable for Remote Mouse Control ............. 38
Connecting to Video Equipment ....................................... 39
Connecting a Composite Video Source ......................... 40
Connecting an S-Video Source ........................................ 41
Connecting a Component Video Source ......................... 42
Connecting an RGB Video Source .................................... 43
Connecting to a Digital Camera or Other Device ............. 44
Removing the USB Cable ............................................... 44
Playing Sound Through the Projector .............................. 45
Connecting External Speakers ...................................... 46
Presenting Through a Wireless Network .......................... 47
Starting EasyMP ........................................ 48
Configuring Basic Settings .................................. 49
Configuring the Connection .................................. 50
Using Ad Hoc Mode ........................................ 51
Using Access Point Mode .................................... 57
Using Wireless Security Options ............................ 67
Enabling WEP Encryption .................................... 67
Enabling WPA Security ....................................... 69
Enabling EAP, LEAP, or PEAP Authentication .......... 70
Enabling EAP-TLS Certificate Validation ................ 72
Projecting Over a Network .................................... 73
Solving Connection Problems ............................... 75
Using the Control Bar ....................................... 76
Connecting in Advanced Connection Mode ............. 77
Enabling Network Security .................................. 78
Multi-screen Projection ....................................... 81
Projecting Video Clips ....................................... 83
Using Special Presentation Modes ......................... 84
Using Presentation Mode .................................... 85
Using Presenter View ........................................ 85
Removing the Wireless 802.11g/b/a Module ............ 89
Connecting to a Wired Network ............................. 89
Using Projector E-mail Alerts ............................... 91

Presenting from a Digital Camera or External Drive .................. 93
Creating a Slideshow on the Fly ............................. 94
Displaying the Slideshow .................................... 94
Controlling Your Slideshow .................................. 95
Changing Timing and Other Settings ...................... 95
Presenting Image Files From a Digital Camera .......... 97
Presenting Image Files From an External Drive .......... 98
Creating a Scenario ......................................... 99
Converting a PowerPoint File to a Scenario .............. 99
Creating a Scenario from Scratch ........................ 100
Transferring Your Scenario to a USB Drive ............... 108
### Presenting Scenarios
- Controlling Your Scenario
- Supported File Formats

### Fine-Tuning the Projector
- Using the Menu System
  - Restoring the Default Settings
- Adjusting the Image
  - Six-Axis Color Adjustment
- Adjusting Signal Settings
- Customizing Projector Features
- Using the Projector Security Features
  - Enabling Password Protection
- Creating Your Own Startup Screen
- Disabling the Projector’s Buttons
- Customizing Power and Operation
- Multi-screen Color Adjustment

### Managing Projectors
- Using EMP Monitor
  - Opening and Closing EMP Monitor
  - Registering a Projector
  - Monitoring Your Projectors
  - Controlling Your Projectors
  - Configuring the Monitoring Interval
- Using E-mail Alerts
- Understanding the Notification Messages
- Using a Browser to Monitor the Projector

### Maintaining the Projector
- Cleaning the Lens
- Cleaning the Projector Case
- Cleaning the Air Filter and Vent
- Replacing the Lamp and Air Filter
  - Resetting the Lamp Timer
- Transporting the Projector
The PowerLite® 1705c/1715c is an easy-to-use projector that weighs less than 4 pounds. The projector offers up to 2700 lumens (1715c) or 2200 lumens (1705c) of brightness. You can connect it to a wide range of computers and video sources, or you can project from a USB storage device, or over an 802.11g, 802.11b, or 802.11a wireless network.

**Easy setup, control, and security:**
- 5-second startup time and Instant Off® feature for fast setup and shut down
- Automatic digital keystone correction
- 1.2x optical zoom lens for flexible placement and positioning
- Security features include password, user's logo, and the ability to lock the projector buttons
- A/V mute slide to block the lens and save lamp life when you want to temporarily stop projecting

**New features and industry firsts:**
- Connect two computers, one via USB 2.0 cable and another via VGA cable for multi-source presentations
- Wirelessly send MPEG2 full screen video with audio from a PC
- Project up to four different images from one computer
- Color match images from up to four projectors for a uniform, wide-screen view
- Project only the PowerPoint® slide images while viewing handout notes and controls on the computer screen
- Perform six-axis color adjustment for fine art and photography
Using Your Documentation

This book contains all the information you need to set up and use your projector. Please follow these guidelines as you read through it:

- Warnings must be followed carefully to avoid bodily injury.
- Cautions must be observed to avoid damage to your equipment.
- Notes contain important information about your projector.
- Tips contain additional projection hints.

Getting More Information

Need tips on giving presentations? Quick steps for setting up your projector? Here’s where you can look for help:

- Quick Setup sheet
  Gives you the instructions you need to get your projector up and running if you are connecting to a notebook, MacBook™, PowerBook®, or iBook® computer, or projecting over a wireless network.

- Projector kit
  Includes this User’s Guide, your Quick Setup sheet, warranty brochures, and Epson PrivateLine® Support card. Keep the kit with your projector at all times.

- Built-in help system
  Provides assistance for common problems. Available from the Help button on the projector or the remote control. See page 154 for details.

- epson.com/support
  Download FAQs and e-mail your questions to Epson support.

- If you still need help after checking this User’s Guide and the sources listed above, you can use the Epson PrivateLine Support service to get help fast. Call (800) 637-7661 and enter the PIN on the PrivateLine card. Or take advantage of Epson’s automated support services 24 hours a day. See page 168 for more information.
presentersonline.com

Includes a library of articles covering presentation tips, tricks, and technology. The site provides templates, clip art and sound clips, as well as Presenters Services to use on the road. Even more resources and services are available if you register to join the Presenters Club—and it’s free.

Registration and Warranty

Your projector comes with a basic carry-in 2-year and 90-day lamp warranty as well as an international warranty that let you project with confidence anywhere in the world. For details, see page 188 and the warranty brochure included with your projector.

In addition, for customers who register their projector, Epson offers free Extra Care® Road Service. In the unlikely event of an equipment failure, you won’t have to wait for your unit to be repaired. Instead, Epson will ship you a replacement unit anywhere in the United States or Canada, usually via overnight delivery. See the brochure included with your projector for details.

To register, simply fill out the registration card and mail it to Epson. Or you can register online at http://www.epson.com/webreg. Registering also lets you receive special updates on new accessories, products, and service.
Unpacking the Projector

After unpacking the projector, make sure you have all the parts shown below:

- Projector
- PDF manual and registration CD-ROM
- EasyMP software CD-ROM
- Wireless module
- Security screw
- Audio adapter
- Remote control and 2 AAA batteries
- USB cable
- Carrying case
- Power cable
- VGA computer cable

Save all packaging in case you need to ship the projector. Always use the original packaging (or the equivalent) when you need to send the projector to another location. If you are moving the projector by hand, use the carrying case. See page 13 for ordering information, and page 152 for transportation instructions.
Additional Components

Depending on how you plan to use the projector, you may need additional components:

- To receive an S-Video signal, you’ll need an S-Video cable. One may be provided with your video equipment, or you can purchase one from Epson; see below.

- To receive a component video signal from a VCR or other video device, you’ll need an HD15 to component video cable. You can purchase one from Epson; see below.

Optional Accessories

To enhance your use of the projector, Epson provides the following optional accessories:

<table>
<thead>
<tr>
<th>Product</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replacement lamp</td>
<td>V13H010L38</td>
</tr>
<tr>
<td>Air filter replacement set (2 filters)</td>
<td>V13H13408</td>
</tr>
<tr>
<td>Universal ceiling mount</td>
<td>ELPMBUNI</td>
</tr>
<tr>
<td>False ceiling plate</td>
<td>ELPMBFPC</td>
</tr>
<tr>
<td>Security bracket/cabling for gyro lock mounts</td>
<td>ELPMBSEC</td>
</tr>
<tr>
<td>Adjustable ceiling channel</td>
<td>ELPMBACC</td>
</tr>
<tr>
<td>Suspension adapter</td>
<td>ELPMBAPL</td>
</tr>
<tr>
<td>Kensington® security lock</td>
<td>ELPSSL01</td>
</tr>
<tr>
<td>50-inch portable screen (4:3 aspect ratio)</td>
<td>ELPSC06</td>
</tr>
<tr>
<td>60-inch portable pop-up screen (4:3 aspect ratio)</td>
<td>ELPSC07</td>
</tr>
<tr>
<td>80-inch portable pop-up screen (4:3 aspect ratio)</td>
<td>ELPSC08</td>
</tr>
<tr>
<td>83.6-inch hanging pull-down screen (4:3 aspect ratio)</td>
<td>ELPSC09</td>
</tr>
<tr>
<td>Component video cable</td>
<td>ELPKC19</td>
</tr>
<tr>
<td>S-Video cable</td>
<td>ELPSV01</td>
</tr>
<tr>
<td>Distribution amplifier</td>
<td>ELPDA01</td>
</tr>
<tr>
<td>Image presentation camera (ELPDC05)</td>
<td>V12H162020</td>
</tr>
<tr>
<td>Ethernet LAN module</td>
<td>V12H005M02</td>
</tr>
</tbody>
</table>

You can purchase screens, carrying cases, or other accessories from an Epson authorized reseller. To find the nearest reseller, call 800-GO-EPSON (800-463-7766). Or you can purchase online at www.epsonstore.com (U.S. sales) or www.epson.ca (Canadian sales).
Displaying and Adjusting the Image

Whether you’re presenting from a computer or video equipment, you need to follow some basic steps to display your image on the screen.

Follow the guidelines in this chapter for:

- Positioning the projector
- Turning the projector on and selecting the image source
- Troubleshooting display problems
- Adjusting the image
- Turning off the projector
Positioning the Projector

If the projector isn’t already installed in the room you’re using, you’ll probably want to place it on a table in front of the screen, as shown. This lets you stand in the front of the room, face the audience, and remain close enough to the equipment to be able to control it. Try to leave as much space as possible between the projector and the screen to get a good-size image.

Use the figure below to help you determine placement. Image size increases with distance, but can vary depending on how you position the zoom ring and whether you’ve adjusted the image with other settings.

Also keep these considerations in mind:

■ Place the projector on a sturdy, level surface.

■ Make sure there is plenty of space for ventilation around and under the projector. Do not set the projector on top of anything that could block the vents under the projector.

■ Make sure the projector is within 10 feet of a grounded electrical outlet or extension cord.
Ideally, you should place the projector directly in front of the center of the screen, facing it toward the screen squarely. The base of the lens should be at about the level of the bottom of the screen.

If you place the projector below screen level, you'll have to tilt it up by extending the front adjustable foot. This causes the image to become “keystone” shaped, but you can correct the distortion by pressing the buttons on the projector. See page 23 for detailed information about correcting the image shape.

For instructions on installing the projector in a permanent location, such as a theater or conference room, see page 175.

**Projecting the Image**

Make sure your projector and other equipment are set up as described on page 35. Then follow the instructions below to start the projector and display an image.

**Turning On the Projector**

Turn on any connected computer or video equipment before starting the projector so it can automatically detect and display the image source. If you turn on the projector first, or have multiple pieces of connected equipment, you may have to select the image source manually (see page 19).
Follow these steps to turn on the projector:

1. Open the A/V Mute slide (lens cover).

2. Plug one end of the power cable into the projector, and the other end into an electrical outlet.

The **Power** light turns orange.

---

**note**

To shut down the projector, see page 25. Shutting down the projector correctly prevents premature lamp failure and possible damage from overheating.
3. Press the red Power button on the remote control or on top of the projector.

The projector beeps once and the Power light flashes green as the projector warms up, then an image begins to appear. When the Power light stops flashing and remains green, the projector is ready for use.

4. If you’ve connected a Windows-based computer to the projector, you may see a New Hardware Wizard screen saying your computer has found a plug-and-play monitor; if so, click Cancel.

5. If you are prompted to enter a password, see page 121.

Selecting the Image Source

Selecting the image source lets you switch between images input from different pieces of connected equipment (such as a computer or DVD player).

If you don’t see the image you want, press the Source Search button on the projector or the Search button on the remote control until you see the image you want to project.

You can also use the Source buttons on the remote control to switch between devices connected to the ports identified on each button, or select EasyMP™ to project wirelessly or from a USB drive.

warning
Never look into the lens when the lamp is on. This can damage your eyes, and is especially dangerous for children.

note
To focus and adjust the image, see page 22. If a projected image fails to appear, see page 20 for help.
Troubleshooting Display Problems

Follow these guidelines if you’re having trouble displaying an image.

**You Can’t Project an Image**

If you don’t see the image you are trying to project, try the following:

- Make sure the cables are connected correctly, as described beginning on page 35.
- Make sure the Power light is green and not flashing and the A/V Mute slide is open.
- If you’ve connected more than one computer and/or video source, you may need to press the Source Search button on the projector’s control panel or Search button on the remote control to select the correct source. (Allow a few seconds for the projector to sync up after pressing the button.)
- If you’re using a PC notebook, press the function key on your keyboard that lets you display on an external monitor. It may be labeled CRT/LCD or have an icon such as Ą/č. You may have to hold down the Fn key while pressing it. Allow a few seconds for the projector to sync up after changing the setting.

**The Projector and Notebook Don’t Display the Same Image**

If you’re projecting from a notebook, and you can’t see your image on the projection screen and on your computer at the same time, follow these guidelines.

**If you’re using a PC notebook:**

- On most systems, there’s a function key that lets you toggle between the LCD screen and the projector, or display on both at the same time. It may be labeled CRT/LCD or have an icon such as Ą/č. You may have to hold down the Fn key while pressing it. Allow a few seconds for the projector to sync up after changing the setting.
If the function key doesn’t permit you to display simultaneously on both screens, you should check your monitor settings to make sure both the LCD screen and the external monitor port are enabled.

From the Control Panel, open the Display utility. In the Display Properties dialog box, click the Settings tab, then click Advanced. The method for adjusting the settings varies by brand; you may need to click a Monitor tab, then make sure the external Monitor port is set as your primary display and/or enabled. See your computer’s documentation or online help for details.

**If you’re using Mac OS X:**
You may need to set up your system to display on the projector screen as well as the LCD screen. Follow these steps:

1. From the Apple® menu, select System Preferences, then select Displays.
2. Make sure the VGA Display or Color LCD dialog box is selected.
3. Click the Arrangement (or Arrange) tab.
4. Make sure the Mirror Displays checkbox is selected.
Adjusting the Image

Once you see your image, you need to make certain adjustments:

■ If the image is too high or too low, you can reposition it. See below.
■ To focus or zoom your image, see page 23.
■ If the image isn’t square, see page 23.
■ If a computer image displays incorrectly, see page 25.
■ If you need to fine-tune the image and/or sound, see Chapter 6.

Adjusting the Height of Your Image

If the image is too low on the screen, you can use the front adjustable foot to raise it.

1. Stand behind the projector. Press the blue foot release lever up and lift the front of the projector.

2. Once the image is positioned where you want it, release the lever to lock the foot in position.

3. If necessary, you can fine-tune the height or level the image by turning the projector’s adjustable rear foot.

Raising the projector causes the image to distort or “keystone,” but you can correct the shape as described on page 23.
**Focusing and Zooming Your Image**

Turn the focus ring on the projector to sharpen the image.

Turn the zoom ring on the projector to reduce or enlarge the image.

If the image still isn’t large enough, you may need to move the projector farther away from the screen. You can also use the E-Zoom buttons on the remote control to zoom in on a portion of the image. See page 31 for instructions.

**Adjusting the Image Shape**

In most cases, you can maintain a square or rectangular image by placing the projector directly in front of the center of the screen with the base of the lens level with the bottom of the screen.

Even if the projector is slightly tilted (within a range of 30° up or down), the projector has an automatic keystone correction function that detects and corrects vertical keystone distortion.

It takes about one second after projection starts for the image to be corrected. During this time, a vertical keystone correction gauge appears on the screen.

If your image is still distorted, you can correct it using the Keystone buttons on the projector’s control panel or the projector’s Setting menu.
Using Keystone Correction

To adjust your image when it is wider on the top or bottom, do the following:

- Press one of the two triangular buttons on the projector’s control panel, as shown below. Continue pressing the button until you are satisfied with the shape of the image.

![Diagram showing triangular buttons and image adjustment]

- Or press the Menu button on the remote control or projector, select the Setting menu, and press Enter.

![Diagram showing menu selection]

From the Setting menu, select Keystone and press Enter. Use the pointer button on the remote control to adjust the keystone setting as needed.

If the image becomes uneven, decrease the sharpness setting. (See page 117.)

**note**
The image will be slightly smaller after adjusting. If it’s important to maintain the correct aspect ratio, use the menu system to perform keystone correction, then use the remote’s Resize button to adjust the aspect ratio. See page 32.
Correcting Computer Images

If you’re connected to a computer and the image doesn’t look right, press the **Auto** button on the remote control or the **Enter** button on the projector. This automatically resets the projector’s tracking, sync, resolution, and position settings.

If the **Auto** button doesn’t correct the problem, you may need to adjust the tracking or sync using the projector’s Signal menu. See page 119 for more information.

Using the A/V Mute Slide

You can use the A/V Mute slide to temporarily turn off the image and sound when you want to redirect your audience’s attention.

Shutting Down the Projector

When you’ve finished using the projector, follow the recommended procedure to shut it down. This extends the life of the lamp and protects the projector from possible overheating.

1. Turn off any equipment plugged into the projector.
2. To turn off the projector, press the red **Power** button on the remote control or projector.

*note*

You must be projecting an image for this button to have any effect. The **Auto** button works only with computer images projected through the VGA port.

Lamp life results will vary depending on mode selected, environmental conditions, and usage.

Turn off this product when not in use to prolong the life of the projector.
You see a confirmation message. (If you don’t want to turn it off, press any other button.)

3. Press the \textcopyright Power button again. The lamp turns off. When the projector beeps twice, you can unplug the power cord.

(If the projector is mounted on the ceiling, you will need to wait 20 seconds for the projector to cool down before you can unplug the power cord.)

If you want to turn the projector on again, make sure the orange light is not flashing, then press the \textcopyright Power button.

4. If you extended the adjustable front foot, press up on the blue foot release lever to retract it.

5. Close the A/V Mute slide.

\textbf{Using the Direct Power On Function}

The Direct Power On function enables faster setup. The projector will start up automatically when you plug it in; you won’t have to press the \textcopyright Power button.

Follow these steps to enable Direct Power On:

1. Press the Menu button on the remote control and select the Extended menu.

2. Choose Operation and press Enter.


5. Press Esc or Menu to exit. The setting will take effect the next time you plug in the projector.
Using the Remote Control

The projector includes a number of tools to enhance your presentation. All of them can be accessed using the remote control, which lets you operate the projector from anywhere in the room—up to 20 feet away.

You can use the remote control to adjust the picture and sound (page 29) or as a pointer to highlight your presentation (page 34). You can also use it to adjust the color mode for various environments (page 32) or as a wireless mouse when projecting from a computer (page 33).

This chapter covers:
- Using the remote control
- Controlling the picture and sound
- Operating your computer with the remote control
- Highlighting your presentation
Using the Remote Control

Follow these tips for using the remote control:

- Point the remote control at the front of the projector or at the screen.
- Stand within 20 feet of the projector.
- Avoid using the remote under bright fluorescent lamps or in direct sunlight, or the projector may not respond properly.

Replacing the Batteries

Replace the batteries as described below:

1. Turn the remote control over.
2. Press down on the tab on the battery cover as you lift the cover off.
3. Install two AAA batteries, inserting the + and – ends as shown.
4. Position the cover as shown, then press down until it snaps into place.

note
If a button is pressed longer than 30 seconds, the remote control stops operating to conserve power. When you release the button, normal operation resumes.

cautions
When replacing batteries, take the following precautions:
- Replace the batteries as soon as they run out. If the batteries leak, wipe away battery fluid with a soft cloth. If fluid gets on your hands, wash immediately.
- Do not expose batteries to heat or flame.
- Dispose of used batteries according to local regulations.
- Remove the batteries if you won’t be using the projector for a long period of time.

warning
If a button is pressed longer than 30 seconds, the remote control stops operating to conserve power. When you release the button, normal operation resumes.
Controlling the Picture and Sound

You can use the remote control to preview and select your picture sources, temporarily turn off the picture and sound, freeze the action, zoom in on the picture, and adjust the volume.

Switching Between Picture Sources

If your projector is connected to more than one computer and/or video source, you can switch between the different sources:

- The easiest way to select your source is to press the Search button on the remote control (or the Source Search button on the projector) repeatedly until you see the image you want on the screen.

- On the remote control, there are four Source buttons. Use them to switch between equipment connected to the port identified on each button, or to use EasyMP.

After you select a source, the screen goes dark for a moment before the image appears.
Turning Off the Picture and Sound

You can use the A/V Mute button on the remote control to turn off the image and sound. This does the same thing as the A/V Mute slide and is useful if you want to temporarily redirect your audience’s attention.

■ To turn off the picture and sound, press the A/V Mute button. The screen turns black.

■ To turn the image and sound back on, press the button again.

You can have the screen turn blue when you press the A/V Mute button. You can also have an image, such as a company logo, display on the screen (see page 124).

Stopping Action

You can use the remote control to stop the action in your video or computer image.

■ To stop the action and keep the current image on the screen, press the Freeze button. The sound continues.

■ To restart it, press the Freeze button again.

---

note

This function pauses the image, but not the sound. Also, because the source continues to transmit signals, you won’t resume the action from the point you stopped it.
**Zooming Part of Your Image**

You can zoom in on a portion of the image using the E-Zoom buttons on the remote control.

1. Press the E-Zoom button on the remote control.
   - You see a crosshair indicating the center of the zoom-in area.
2. Use the pointer button to position the crosshair.
3. Continue pressing the E-Zoom button to enlarge the selected area up to 4 times.
4. While the image is enlarged, you can:
   - Use the pointer button to move around the screen.
   - Press the E-Zoom button to zoom out.
5. When done, press the Esc button to return the image to its original size.

**Controlling the Volume**

To change the volume, press the or button on the remote control or projector.

You can also adjust the volume using the projector’s menu system. See page 120.
**Resizing Video Images**

You can use the Resize button on the remote control to adjust how an image fits into the display area.

For video images, press Resize to switch the aspect ratio between 4:3 and 16:9, (and Normal for computer images). This lets you play certain digital video images or movies recorded on certain DVDs in 16:9 widescreen format.

For computer images, resizing is normally unnecessary, since the projector automatically resizes the image to make the best use of the display area. If you press the Resize button on the projector or remote control, the projector displays the image at the output resolution of the computer (which makes the image larger or smaller, depending on its resolution). If the resolution of the image is the same as the projector’s (1024 × 768), pressing Resize has no effect.

**Adjusting the Color Mode**

You can use the Color Mode button on the remote control to adjust the color, brightness, and other aspects of your image.

Press the button repeatedly to select from the following settings:

- **Photo**: For vivid, high-contrast still images in a bright room.
- **Sports (video, S-video, or composite video only)**: For vivid TV images projected in a bright room.
- **Presentation**: For computer presentations (the default when projecting from a computer with analog video).
- **Theatre**: For optimizing movie images with increased contrast.
- **Game**: For increased brightness when playing video games or watching TV in a bright room. Emphasizes dark gradations.
- **sRGB**: For matching the color palette of standard sRGB computer displays.
- **Blackboard**: For projecting accurate colors on a green chalkboard (adjusts the white point).
- **Customized**: For manual color adjustment. (See page 116).
Operating Your Computer with the Remote Control

If you connect a computer to the projector with a USB cable, as described on page 38, then select Link21L for the USB Type B setting in the Extended menu (see page 128), you can use the remote control in place of your computer’s mouse. This gives you more flexibility when delivering slideshow-style presentations, since you won’t have to stand next to the computer to change slides.

- Use the Up and Down buttons to move through a slideshow.

- Use the pointer button to move the cursor on the screen.

- Press the Enter button once to left-click, or press it twice to double-click. Press the Esc button to right-click.

- To drag-and-drop, hold down the Enter button. Then use the pointer button to drag the object. When it’s where you want it, press Enter to release it.
**Highlighting Your Presentation**

You can display a pointer to call out important information on the screen. If you want to customize the pointer tool, you can choose from three alternative shapes.

**Using the Pointer Tool**

1. To activate the pointer tool, press the **Pointer** button on the remote control. A pointer appears on the screen.

   ![Pointer](image1)

   If you prefer to use a different style of pointer, see the instructions in the next section.

2. Use the 🔄 pointer button on the remote control to position the pointer on the screen.

3. When you’re done using the pointer, press **Esc** to clear the screen.

**Customizing the Pointer Tool**

You can change the appearance of the pointer by choosing from three alternative shapes.

1. Press the **Menu** button on the remote control, highlight the **Settings** menu, highlight **Pointer Shape**, and press **Enter**. You can select one of the pointer shapes shown at the left.

2. Select the shape you want and press **Enter**.

3. Highlight **Return** and press **Enter**.

4. Press **Menu** to exit from the menu system.
Connecting to Computers, Cameras, and Other Equipment

This chapter tells you how to connect the projector to a notebook or desktop computer, and/or to video equipment, such as a VCR, DVD player, or video camera. You can also connect the projector to a USB storage device, digital camera, or external speakers.

Follow the instructions in this chapter on:

- Connecting to a computer
- Connecting video equipment
- Connecting to a digital camera or other USB device
- Playing sound through the projector
Connecting to a Computer

You can connect the projector to any computer that has a standard video output (monitor) port, including desktop models, PC notebook and notebook computers, MacBooks, PowerBooks and iBooks, and hand-held devices.

You can also connect a Windows computer to the Type B USB port on the projector. This allows you to connect two computers to the projector, one to the video port and one to the USB port.

- To connect to the blue Computer/Component Video port (standard VGA cable connection), see the instructions below.
- To connect to the projector’s USB port, see page 38.

Connecting to the Computer Port

You can connect to the blue Computer/Component Video port using the VGA computer cable that came with the projector (the monitor port on your computer must be a mini D-sub 15-pin port).

1. If you’re using the VGA computer cable, connect one end to the projector’s blue Computer/Component Video port, and the other end to your computer’s monitor port. Then go to step 3.

2. You can connect an optional stereo mini-jack audio cable to play sound through the projector (see page 45), or connect a USB cable to use the remote control as a mouse (see page 38).
3. When you’ve finished making any connections, see page 17 for instructions on turning on the projector and adjusting the image.

**Connecting to the USB Port**

You can connect a Windows XP or Windows 2000 (SP4) computer to the projector’s Type B (square) USB port and project your computer’s display. This allows you to connect two computers at the same time. A USB 2.0 connection provides better picture quality and response than USB 1.1.

The first time you connect a computer to the projector’s USB port, software from the projector installs on your computer.

1. Follow the instructions beginning on page 17 to turn on the projector and adjust the image.
2. Turn on your computer.
3. Locate the USB cable that came with your projector.
4. Connect the square end of the cable to the projector’s Type B (square) USB port.
5. Connect the flat end of the cable to any available USB port on your notebook or desktop computer.

Messages appear as the projector is recognized and the software installation begins.

**note**

*The USB Display feature is not available on Windows 98, Windows Me, or Macintosh. You must be able to install software on your computer to use this feature.*

*You can’t use the remote mouse control function when you use the USB port to project your computer’s display.*
6. Follow the instructions on your computer screen to install the Epson USB Display software. If you see a “Digital Signature Warning,” select Continue. You will only need to install the software the first time you connect.

After the software has installed, you see your computer’s desktop displayed by the projector. “Easy MP” appears briefly in the upper right corner of the image.

**Connecting the Cable for Remote Mouse Control**

If you’ve connected a computer as described in this chapter (using the Computer/Component Video port) and set the USB Type B setting under the projector’s Extended menu to Link21L (see page 128), you can use the projector’s remote control as a wireless mouse. This lets you control your computer and click through slideshow-style presentations, such as PowerPoint, from up to 20 feet away.

The wireless mouse function is supported on systems with a USB port running Windows XP, 98SE, Me, or 2000, or Mac OS X 10.2.x to 10.4.x. This function is not supported if you use an S-Video cable to connect your computer to the projector.

1. Locate the USB cable that came with your projector.
2. Connect the square end of the cable to the projector’s USB port.
3. Connect the flat end of the cable to any available USB port on your notebook or desktop computer.

4. If necessary, configure your computer to work with an external USB mouse. See your computer documentation for details.

Connecting to Video Equipment

You can connect several video sources to the projector at the same time. Before starting, look at your video equipment to determine its available video output connections:

- If your video player has a yellow RCA-style video output connector, see “Connecting a Composite Video Source” on page 40.
- If your video player has an S-Video connector, see “Connecting an S-Video Source” on page 41.
- If your video player has a component video port (three connectors labeled either Y/Cb/Cr or Y/Pb/Pr), see “Connecting a Component Video Source” on page 42.
- If your video player has an RGB video port (either a single connector for a VGA-style monitor cable or three connectors labeled R/G/B), see “Connecting an RGB Video Source” on page 43.

After connecting video cables, you may also want to connect an audio cable to play sound through the projector; see page 45.
**Connecting a Composite Video Source**

1. Locate an RCA-style video cable (one is usually provided with your video equipment or you can purchase one from an electronics dealer).

2. Connect the cable to the yellow video output connector on your player and the yellow Video connector on the projector:

3. If you want to play sound through the projector, see page 45 for instructions on connecting audio cables.

4. If you don’t need to make any other connections, see page 17 or the Quick Setup sheet for instructions on turning on the projector and adjusting the image. Once the projector is turned on, select the image source: press the Search button on the remote control or press the Source Search button on the projector’s control panel repeatedly until the image appears.
**Connecting an S-Video Source**

1. Locate an S-Video cable (one is usually provided with your video equipment or you can purchase one from Epson; see page 13).

2. Connect the cable to the S-Video connector on your player and the S-Video connector on the projector:

3. If you want to play sound through the projector, see page 45 for instructions on connecting audio cables.

4. If you don’t need to make any other connections, see page 17 or the **Quick Setup** sheet for instructions on turning on the projector and adjusting the image. Once the projector is turned on, select the image source: press the **Search** button on the remote control or press the **Source Search** button on the projector’s control panel repeatedly until the image appears.
Connecting a Component Video Source

You will need a component-to-VGA video cable or a component video-to-VGA adapter for this connection. You can order the component-to-VGA cable (ELPKC19) from Epson; see page 13 for more information.

1. Locate a component-to-VGA video cable or adapter.
2. Connect the cable to your player and the blue **Computer/Component Video** connector on the projector.

3. If you want to play sound through the projector, see page 45 for instructions on connecting audio cables.

4. If you don’t need to make any other connections, see page 17 for instructions on turning on the projector and adjusting the image. Once the projector is turned on, select the image source: press the **Search** button on the remote control or press the **Source** **Search** button on the projector’s control panel repeatedly until the image appears.

---

**note**

Be sure your video player is not an RGB video source. If you select the wrong source, image quality may suffer. Check your video player’s documentation.

Also, make sure the **Computer Input** setting in the **Signal** menu is set to **Auto** or **Component Video** (see page 119).
Connecting an RGB Video Source

1. Locate the VGA computer cable provided with the projector.

2. Connect the cable to the video port on your player and the Computer/Component port on the projector.

3. If you want to play sound through the projector, see page 45 for instructions on connecting audio cables.

4. If you don’t need to make any other connections, see page 17 for instructions on turning on the projector and adjusting the image. Once the projector is turned on, select the image source: press the Search button on the remote control or press the Source Search button on the projector’s control panel repeatedly until the image appears.

*note*
Be sure your video player is not a component video source. If you select the wrong source, image quality may suffer. Check your video player’s documentation.
**Connecting to a Digital Camera or Other Device**

You can connect your digital camera, USB flash memory drive, USB hard drive, or multimedia storage viewer, such as the Epson P-4000 or iPod® photo. Use the USB cable specified for your device. Then you can use your device’s slideshow function or the projector’s EasyMP PC Free feature (see page 93) to present images.

1. Connect the flat end of the USB cable to the flat USB port on the projector, as shown.

2. Connect the other end of the cable to your camera or other device.

**Removing the USB Cable**

If you’re using PC Free mode to project your images, exit PC Free mode before you remove the USB cable from the projector.

1. Position the cursor over the Exit button in the upper right corner of the PC Free screen.
2. Press the Enter button on the remote control to close PC Free mode.
3. Disconnect the USB cable.

---

**note**

Use a cable less than 10 feet long and connect the camera directly to the projector. Your projector may not function correctly if you use a longer cable or connect your camera to a USB hub.

If you connect a USB hard drive, make sure you use the AC adapter to power the hard drive.

The slideshow function on some devices may not work with the USB connection.
Playing Sound Through the Projector

You can play sound through the projector's speaker system or attach an external speaker system.

To play sound through the projector, follow these steps:

1. Locate the appropriate cable and connect it to the Audio jack on the projector.

   - If you have a computer connected to the blue Computer/Component Video port, use a stereo mini-jack cable.

   - If you have video equipment connected to the Video or S-Video port, use an RCA-style audio cable and the audio adapter included with the projector.

2. Connect the other end of the cable to the audio output connector(s) on your computer or video equipment.
Connecting External Speakers

When you use EasyMP, you can output the sound to external speakers with built-in amplifiers. First, you need to use the Settings menu to set the EasyMP Audio Out option to External. See page 121 for instructions.

To connect speakers to the projector, follow these steps:

1. Locate the appropriate cable to connect your speakers.
   Depending on your speakers you may be able to use a commercially available audio cable with a stereo mini-jack connector on one end and pin jacks on the other end. For some speakers, you may have to purchase a special cable or use an adapter.

2. Connect the stereo mini-jack end of the audio cable to the Audio port on the projector.

3. Connect the other end(s) of the cable to your speakers.
   The projector’s internal speaker system is disabled while sound is output to external speakers, and you can’t use the projector or remote control to control the volume.
Presenting Through a Wireless Network

This chapter tells you how to send pictures to the projector through a wireless network. Using EMP NS Connection, you can project images shown on your computer screen—including text, graphics, and video—directly to your audience.

You’ll find instructions in this chapter on:

■ Starting EasyMP
■ Configuring basic settings
■ Connecting to the projector in Ad Hoc (computer-to-computer) mode or Access Point (infrastructure) mode
■ Using wireless security options
■ Projecting wirelessly
■ Multi-screen projection
■ Projecting video clips
■ Using special presentation modes
■ Removing the wireless 802.11g/b/a module
■ Projecting from a wired LAN
■ Sending e-mail alerts from the projector

Before starting, make sure you’ve installed EMP NS Connection as described on page 171 for each computer you want to connect to the projector. Then follow the steps in this chapter to start EasyMP, configure your projector and computer, and run EMP NS Connection.
Starting EasyMP

Before connecting to the projector, you have to switch it to EasyMP mode. Follow these steps:

1. Point the remote control at the projector and press the Power button.

2. Press the EasyMP button on the remote control to select EasyMP as the source.

   You see this screen. The network settings appear in the lower left.

3. If you’ve already set up your computer and projector for the mode you want to use—Ad Hoc mode (also called computer-to-computer mode) or Access Point mode (also called infrastructure mode)—skip to “Projecting Over a Network” on page 73.

   Otherwise, continue with the next section.

Note

Use only the Epson 802.11g/b/a wireless module in the projector.

If you see a message asking you to insert a LAN or memory card, check to make sure your 802.11 g/b/a module is properly inserted, as described on the Quick Setup sheet.
Configuring Basic Settings

You can give your projector a unique name, enable a projector keyword, or create a password for controlling the projector over the Web.

1. Press the Menu button, then choose Network and press Enter.
2. Choose To Network Configuration and press Enter.
3. Choose Basic and press Enter.

You see the following screen:

4. Make sure the projector has a unique name, so you can identify it when connecting to it from your computer.

If you need to rename it, highlight the Projector name text box then press Enter.
5. Press the \( \mathbb{D} \) pointer button to select individual letters; then press Enter to input a character. To add a blank space or to navigate backward and forward through the input text, highlight the arrows and press Enter. To toggle symbol settings or capital letters, highlight the option and press Enter. When you’re done, highlight Finish and press Enter.

6. If you want to create a password for remote access to the projector, highlight Web Control Password, press Enter, and enter a password of up to 8 alphanumeric characters. When you’re done, highlight Finish and press Enter.

7. If you want to set up a security keyword so that only people who are in the same room as the projector can access it, turn Projector keyword on. Then when you want to connect to the projector, it displays a randomized four-digit number or “keyword” on the screen. When prompted by NS Connection, you can enter the keyword on your computer to connect (see page 75).

8. When you’re done making these settings, highlight the Return button at the top of the screen, then press Enter.

Configuring the Connection

You can use NS Connection to connect to the projector and send images wirelessly in two modes: Ad Hoc mode or Access Point mode.

- **Ad Hoc mode** (computer-to-computer mode) lets you connect just one computer to the projector at a time; it’s easy to set up, and the only equipment you need is a computer with a wireless (802.11g, 802.11b, or 802.11a) network card or adapter, or a
Macintosh with an AirPort® or AirPort Extreme card. When you connect with this mode, any connection to other wireless networks is broken; you can connect to the projector only.

- **Access Point mode** (infrastructure mode) lets multiple computers access the projector at the same time and easily trade off control over the projector. To use Access Point mode, you need a wireless (802.11g, 802.11b, or 802.11a) access point or an AirPort Extreme (or AirPort) base station, and one or more computers with wireless network cards or adapters.

Follow the instructions below for the mode you want to use.

**Using Ad Hoc Mode**

To use Ad Hoc (computer-to-computer) mode, adjust your projector and wireless card or adapter settings as described in this section.

**Configuring the Projector**

1. Press the **Menu** button, then choose **Network** and press **Enter**.
2. Choose **To Network Configuration** and press **Enter**.
3. Choose **Wireless LAN** and press **Enter**.

You see this screen:

---

**note**

Make sure you’ve installed the NS Connection software as described on page 171.

To connect to the projector over a wireless network, your computer must be running Windows 2000 or XP. Your Mac must be running Mac OS X 10.3 or later. See page 171 for complete system requirements for projecting wirelessly.

Access Point mode (infrastructure mode) is required to achieve transfer speeds up to 54MB/sec on an 802.11g network. Ad Hoc mode (computer-to-computer mode) limits network connections to 11MB/sec. This is a standard specification of 802.11g networking.
4. Make sure Quick is selected for the Connection mode. If not, use the \( \text{ﬁ} \) pointer button on the remote control to highlight Quick, then press Enter to select it.

5. If your network is using 802.11a, use the \( \text{ﬁ} \) pointer button on the remote control to highlight 802.11a, then press Enter to select it.

6. If your network card supports an SSID or ESSID name (see page 55), highlight the ESSID text box, press Enter, and enter a name:

   Press the \( \text{ﬁ} \) pointer button to select individual letters; then press Enter to input a character. To add a blank space or to navigate backward and forward through the input text, highlight the arrows and press Enter. To toggle symbol settings or capital letters, highlight the option and press Enter. When you’re done, highlight Finish and press Enter.

Note that the ESSID is case-sensitive (if you enter the name in uppercase on the projector, you must type it the same way on the computer connecting to the projector).

7. When you’re done making these settings, highlight the Return button at the top of the screen, then press Enter. Choose Setup Complete and press Enter, then choose Yes and press Enter to save your settings and return to the main EasyMP screen.

Now you’re ready to set up your computer to project wirelessly. Go to “Configuring the Network Settings for Windows” below, or “Setting Up Your Mac for Ad Hoc Mode” on page 55.
Configuring the Network Settings for Windows

Before connecting to the projector, you need to make sure the settings for your notebook’s or PC’s network card match the settings you entered for the projector.

1. Access your wireless network Properties window. For example, in Windows XP you would click Start > Control Panel > Network and Internet Connections. Then click the Network Connections icon. You see a screen similar to this:

![Network Connections window]

Settings may vary, depending on your wireless network adapter. See the documentation for your adapter for more information.

note
On some Windows systems, you can right-click My Network Places or Network Neighborhood on the desktop and select Properties.
2. Right-click the Wireless Network Connection icon and select Properties. You see a screen similar to this:

3. Click the Configure button.

4. Click the Advanced tab. You see a screen similar to this:
5. Check your wireless card or adapter device settings. (Depending on the type of card or adapter you’re using, some of the settings may be different than those listed here.)
   - Set the Network Type to **802.11 Ad Hoc**.
   - Set the SSID to match the name you assigned to the projector’s ESSID.
   - Make sure Encryption is **Disabled**.

6. Click the **General** tab and make sure that your wireless card or adapter is enabled.

7. When you’re done, click **OK** to close the Properties dialog box.

Now you’re ready to connect to the projector. See “Projecting Over a Network” on page 73.

---

**Setting Up Your Mac for Ad Hoc Mode**

Your AirPort software is automatically configured to allow your Mac to detect both computer-to-computer (Ad Hoc) and Access Point networks.

Typically, you only need to select your projector’s ESSID from the AirPort status menu on the Mac menu bar. If you’re having problems detecting the projector, follow these steps:

1. From the Apple pull-down menu, select **System Preferences**.

2. Double-click the **Network** icon. You see the Network settings window.

---

**note**

When you connect in Ad Hoc mode, your computer is disconnected from any other wireless networks. If you need to remain connected to your wireless network, use Access Point mode, as described on page 57. Also, make sure you reconnect to your original wireless network when you are done using the projector.
3. Make sure Location is set to **Automatic**.

![Select Automatic](image)

**note**

If you don’t need the other network port configurations, disable them by deselecting their checkboxes.

When you connect in Ad Hoc mode, your computer is disconnected from any other wireless networks. If you need to remain connected to your wireless network, use Access Point mode, as described on page 57. Also, make sure you reconnect to your original wireless network when you are done using the projector.

4. Select **Network Port Configurations** in the Show pull-down menu.

5. Under Port Configurations, select **AirPort**.

6. Click **Apply Now**. Then close the window.

7. Click the AirPort icon on the menu bar at the top of the Mac desktop. You see the AirPort status menu:

![Choose the ESSID you assigned to the projector](image)

8. Check to make sure AirPort is turned on.

9. Select your projector’s ESSID.
Using Access Point Mode

To use Access Point (infrastructure) mode, first adjust your projector and wireless access point or AirPort base station settings as described in this section.

Configuring the Projector

1. Press the Menu button, then choose Network and press Enter.
2. Choose Wireless LAN and press Enter.
   You see this screen:

3. Make sure Advanced is selected for the Connection mode. If not, use the pointer button on the remote control to highlight Advanced, then press Enter to select it.

4. If your network is using 802.11a, use the pointer button on the remote control to highlight 802.11a, then press Enter to select it.

5. To enable your computer to find the projector on the network, you need to enter an ESSID, which is the SSID name of your access point or the name of your AirPort network. (The name of
Presenting Through a Wireless Network

your AirPort network may be different from that of your AirPort base station; select your base station in the AirPort Admin utility and click Configure to check the name of your network.)

Highlight the ESSID text box, press Enter, and enter a name:
Press the pointer button to select individual letters; then press Enter to input a character. To add a blank space or to navigate backward and forward through the input text, highlight the arrows and press Enter. To toggle symbol settings or capital letters, highlight the option and press Enter. When you’re done, highlight Finish and press Enter.

Note that the ESSID is case-sensitive (if you enter the name in uppercase on the projector, you must type it the same way on the computer connecting to the projector).

6. If your access point assigns IP addresses automatically, turn on DHCP. Otherwise, turn off DHCP and enter the following information:

- **IP address**: Enter the IP address you want to assign to the projector. It must be formatted like other addresses on the network. The last section should be unique.
- **Subnet mask**: For example: 255.255.255.000, but this depends on how your network is set up.
- **Gateway address**: Enter the IP address that was assigned to the access point or AirPort base station when it was set up.
- **DNS server (primary)/DNS server (secondary)**: Enter the IP address that was assigned to the DNS server(s) for your network.

**note**
For specific details about your network, please consult your network administrator.

If you don’t know your gateway or access point address, see page 64. If you’re using AirPort, start the AirPort Admin utility, select your base station and click Configure. Then click the Network tab to see your base station’s IP address.
7. When you’re done making these settings, highlight the Return button at the top of the screen, then press Enter. Choose Setup Complete and press Enter, then choose Yes and press Enter to save your settings and return to the main EasyMP screen.

Now you’re ready to set up your computer for wireless projecting. Go to “Configuring the Network Settings for Windows” below, or go to “Setting Up Your Mac for Access Point Mode” on page 65. If you want to enable security options for your network, see page 67 to set up the option that your network uses on the projector.

**Configuring the Network Settings for Windows**

Before connecting to the projector, you need to make sure the settings for your computer’s wireless card or adapter match the settings you entered for the projector.

1. Access your wireless network Properties window. For example, in Windows XP you would click Start > Control Panel > Network and Internet Connections. Then click the Network Connections icon. You see a screen similar to this:

   ![Network Connections](image)

   Right-click and select Properties

   **note**
   
   On some Windows systems, you can right-click My Network Places or Network Neighborhood on the desktop and select Properties.

   Settings may vary, depending on your wireless network adapter. See the documentation for your adapter for more information.
2. Right-click the Wireless Network Connection icon and select Properties.

You see a screen similar to this:

3. Click the Configure button.

4. Click the Advanced tab. You see a screen like this:
5. Check your wireless card’s or adapter’s device settings. (Depending on the type of card or adapter you’re using, some of the settings may be different than those listed here.)
   - Set the Network Type to **Infrastructure**.
   - Set the SSID to match the name assigned to the access point (which should also be the projector’s ESSID).
   - Make sure Encryption is **Disabled** if you have not set up encryption on the projector.

6. Click the **General** tab and make sure that your wireless card or adapter is enabled.

7. When you’re done, click **OK** to close the wireless properties dialog box.

8. Right-click the **Wireless Network Connection** icon again and select **Properties**. You see this screen:
9. Select Internet Protocol and click the Properties button. You see this screen:

![Internet Protocol (TCP/IP) Properties dialog box]

10. If your access point uses DHCP, select Obtain an IP address automatically. Otherwise select Use the following IP address and enter the required information:

- **IP address**: Type in the IP address you want to assign to the computer. It must be formatted like other addresses on the network. The last section must be unique.
- **Subnet mask**: For example: 255.255.255.000, but this depends on how your network is set up.
- **Default gateway**: Enter the IP address that was assigned to the access point when it was set up.

11. When you’re done, click OK.

12. Click the Wireless Networks tab.

(If you don’t see this tab, you may need to enable your wireless card or adapter by clicking Configure to access the device settings; then follow any instructions on the screen to enable the device.)
You see a screen like this:

![Wireless Network Settings](image)

13. Verify that you’ve enabled your computer’s connection to the access point. It should be listed with the small icon next to it, indicating a connection.

   If it’s not listed, click **Configure** and type the name of your access point.

14. When you’re done making settings, click **OK** to close the dialog box.

Now you’re ready to connect to the projector. See “Projecting Over a Network” on page 73.
Checking the Gateway IP Address on Windows

If you’re entering IP addresses manually and need to find out the gateway IP address (the IP address of your access point), make sure the wireless connection to the access point is currently active, as described in the previous section. Then follow these steps:

1. Access your wireless network Properties window. For example, in Windows XP you would click Start > Control Panel > Network and Internet Connections. Then click the Network Connections icon. You see a screen similar to this:

![Wireless Network Properties Window](image)

Right-click and select Status

2. Right-click the Wireless Network Connection icon and select Status.
3. Click the Support tab. The gateway’s IP address is listed as shown:

![Gateway address]

**Setting Up Your Mac for Access Point Mode**

Your AirPort software is automatically configured to allow your Mac to detect Access Point networks.

Typically, you only need to select your AirPort network name from the AirPort status menu on the Mac menu bar. If you’re having problems connecting to the projector, follow these steps:

1. From the Apple pull-down menu, select **System Preferences**.
2. Click the **Network** icon. You see the Network settings window.
3. Make sure Location is set to Automatic.

4. Select Network Port Configurations in the Show pull-down menu.

5. Under Port Configurations, select AirPort.

6. Click Apply Now. Then close the window.

7. Start the AirPort Admin utility. Select your base station, then click Configure.

8. On the AirPort tab, make sure your AirPort network name matches your projector’s ESSID. If not, enter the projector’s ESSID in the AirPort Network text box and click Update.

9. If you turned DHCP on in your projector’s advanced menu, click the Network tab and make sure the Distribute IP addresses checkbox is selected. If you need to select it, click Update.

**Note**

If you don’t need the other network ports, disable them by deselecting their checkboxes. If more than one network port is enabled, the projector software warns you to turn off AirPort when you first connect the projector. Disregard this message.

Your AirPort network and base station names may be different. To check or change your AirPort network name, start the AirPort Admin utility, select your base station, and click Configure. Click Show All Settings, then make any changes you want on the AirPort tab.

If you’re connecting to your projector in static IP mode, deselect the Distribute IP addresses checkbox. Make sure your projector’s gateway address is identical to the base station’s IP address, and the first three segments of the projector’s IP address are identical to the first three segments of the base station’s IP address.
10. Click the AirPort icon on the menu bar at the top of the Macintosh desktop. You see the AirPort status menu:

11. Check to make sure AirPort is turned on.
12. Select the name of your AirPort network.

**Using Wireless Security Options**

You can use the following security options when connecting to the projector wirelessly: WEP encryption, WPA security, EAP-TLS certificate validation, or LEAP, EAP, or PEAP authentication. To set these security features up on your wireless network, see your documentation or get help from your network administrator. See the following sections to enable the security option on your projector:

- “Enabling WEP Encryption” below
- “Enabling WPA Security” on page 69
- “Enabling EAP, LEAP, or PEAP Authentication” on page 70
- “Enabling EAP-TLS Certificate Validation” on page 72

**Enabling WEP Encryption**

1. Press Menu on the projector remote. Highlight Network and then press Enter.
2. Choose To Network Configuration and press Enter.
3. Highlight Security, then press Enter.
4. Press Enter to show the menu, then highlight **WEP** and press Enter.

5. For the WEP encryption setting, highlight **128 Bit** or **64 Bit** and press Enter.

6. For Format, highlight **HEX** to enable hexadecimal input or **ASCII** to enable text input, then press Enter.

7. If you chose **64 Bit**, choose Key ID 1, 2, 3, or 4.

   Highlight the **Encryption key** text box and press Enter. Press the ✂️ pointer button to select individual letters; then press Enter to input a character. To add a blank space or to navigate backward and forward through the input text, highlight the arrows and press Enter. To toggle symbol settings or capital letters, highlight the option and press Enter. When you’re done, highlight **Finish** and press Enter.

---

**note**

Text input for WEP encryption varies with different access points; check with your network administrator. Try **ASCII** first. If that doesn’t work, try **Text2** and then **Text3**.
8. Check with your network administrator for directions on entering a key for your network, and follow these general guidelines:

- For 128 bit WEP encryption with hexadecimal input, enter 26 characters, from 0 to 9 and from A to F.
- For 64 bit WEP encryption with hexadecimal input, enter 10 characters, from 0 to 9 and from A to F.
- For 128 bit WEP encryption with ASCII or text input, enter 13 alphanumeric characters.
- For 64 bit WEP encryption with ASCII or text input, enter 5 alphanumeric characters.

9. When you’re done making these settings, highlight the Return button at the top of the screen, then press Enter. Choose Setup Complete and press Enter, then choose Yes and press Enter to save your settings and return to the main EasyMP screen.

**Enabling WPA Security**

1. Press Menu. Highlight Network and then press Enter.
2. Choose To Network Configuration and press Enter.
3. Highlight Security, then press Enter.

You see the following screen:
4. Press Enter to show the menu, then choose WPA-PSK (TKIP) or WPA-PSK (AES) and press Enter.

Highlight the PSK (pre-shared key) text box and press Enter. Press the ⏎ pointer button to select individual letters; then press Enter to input a character. To add a blank space or to navigate backward and forward through the input text, highlight the arrows and press Enter. To toggle symbol settings or capital letters, highlight the option and press Enter. When you’re done, highlight Finish and press Enter.

5. When you’re done making these settings, highlight the Return button at the top of the screen, then press Enter. Choose Setup Complete and press Enter, then choose Yes and press Enter to save your settings and return to the main EasyMP screen.

**Enabling EAP, LEAP, or PEAP Authentication**

1. Press Menu. Highlight Network and then press Enter.
2. Choose To Network Configuration and press Enter.
3. Highlight Security, then press Enter.
You see the following screen:

4. Press Enter to show the menu, then choose EAP-TTLS/MD5, EAP-TTLS/MS-CHAPv2, LEAP, PEAP/MS-CHAPv2, or EAP-FAST/GTC and press Enter.

5. Enter the user name and password that match the settings on your authentication server:

Highlight the User name text box and press Enter. Press the pointer button to select individual letters; then press Enter to input a character. To add a blank space or to navigate backward and forward through the input text, highlight the arrows and press Enter. To toggle symbol settings or capital letters, highlight the option and press Enter. When you’re done, highlight Finish and press Enter.

- Highlight the Password text box and press Enter. Enter the password as you entered the User name.
6. When you’re done making these settings, highlight the Return button at the top of the screen, then press Enter. Choose Setup Complete and press Enter, then choose Yes and press Enter to save your settings and return to the main EasyMP screen.

**Enabling EAP-TLS Certificate Validation**

1. Press Menu. Highlight Network and then press Enter.
2. Choose To Network Configuration and press Enter.
3. Highlight Security, then press Enter.

   You see the following screen:

   ![Network settings screen](image)

4. Press Enter to show the menu, then choose EAP-TLS and press Enter.

   The certificate information appears on the screen.

5. When you’re done making these settings, highlight the Return button at the top of the screen, then press Enter. Choose Setup Complete and press Enter, then choose Yes and press Enter to save your settings and return to the main EasyMP screen.
Projecting Over a Network

Once you’ve started EasyMP and set up your projector and computer in either Ad Hoc (Quick) mode or Access Point (Advanced) mode, or in the optional wired LAN mode, as described on page 89, follow these steps to start NS Connection and project over the network.

1. Make sure you’ve set up your projector (see page 48).

2. **Windows**: Select **EMP NS Connection** from the Start menu.
   
   **Mac OS X**: Double-click the **EMP NS Connection** icon in your Applications folder.

3. The first time you start NS Connection, you see this dialog box. Choose a connection mode and click **OK**.

4. If you see a message asking you to disable the firewall, click **Yes** to make an exception for the projector and allow projection.

**note**

If you don’t see your network adapter’s IP address, allow a minute for it to appear. If your access point or AirPort base station uses DHCP (Distribute IP addresses setting is enabled for AirPort), sometimes it takes a minute for the server to pick up the IP address.

Once you’ve selected the IP address for your network adapter, you won’t see the Switch network dialog box when you start NS Connection. If you want to change to a different network adapter, click **Extension** on the EMP NS Connection dialog box, then click **Switch LAN** on the extension dialog box.
You see the screen below. (If you have previously started NS Connection, this may be the first screen you see.)

If the connection is working properly, you see your projector listed. If you have additional Epson projectors on the network, they are also listed, along with their status.

The status is indicated next to each projector’s name.

5. Once the name of your projector appears, select it and click **Connect**. If more than one projector is listed, you can select additional ones and connect to them (up to four) at the same time.

If the selected projector is already being used by another person, you can still connect to it (unless it is “locked”); doing so automatically disconnects the other user. If a projector is locked, you won’t be able to connect to it when it is in use.

If you don’t see the projector, follow the suggestions on page 75.

---

**note**

If a projector is in use and is “locked,” you won’t be able to select it.

To lock the projector from connection by other users while you are connected, click the **Disable interrupt connection** checkbox. De-select it to disable the lock and allow connection by other users.

If PowerPoint is already running when you start the projection and you see a message that says you need to restart PowerPoint, close and reopen PowerPoint after starting NS Connection.
6. If you set up the projector to prompt you for a keyword before connecting, you see a screen like this one:

![Keyboard Input Screen](image)

Type in the four-digit number displayed on the EasyMP Network screen and click **OK**.

7. Once the connection is established, you see your computer’s image transmitted to the screen, and a floating control bar on your computer desktop:

![Control Bar](image)

8. If necessary, you can drag the control bar out of the way on your screen.

9. When you’re done with your presentation, click **Disconnect** on the control bar.

**Solving Connection Problems**

If you don’t see your projector, check the following:

1. Make sure your wireless signal is strong enough to establish a connection. If you have a Mac, check the AirPort icon on the Mac menu bar. For Windows, see the documentation for your access point or wireless network card or adapter.

**note**

If none of these suggestions work, see the troubleshooting information beginning on page 163.
2. Make sure you’re trying to connect to the right network. In Windows, verify that you’ve enabled your computer’s connection to the access point or that your wireless card or adapter is enabled, and that its SSID matches the projector’s ESSID. In Mac OS X, check the AirPort status menu (click the AirPort icon on your menu bar) to make sure AirPort is turned on and the projector’s ESSID or your AirPort network is selected.

3. Make sure you aren’t projecting one of the EasyMP configuration screens. (You should see a message that the projector is ready to connect.) If you have to exit a configuration screen, restart NS Connection.

4. Make sure the ESSID for your projector matches the SSID for your wireless card, adapter, or access point. If you have an AirPort base station, make sure the projector’s ESSID matches the AirPort network name. Remember that the ESSID is case-sensitive.

5. Check the IP address for both your projector and your wireless card, adapter, access point, or AirPort base station. The first three segments of the IP address should be identical. The last segment of the projector’s IP address should be close, but not identical, to the last segment of the IP address for your wireless interface, access point, or base station.

6. Restart your computer and start NS Connection again.

7. If you still don’t see your projector, follow the instructions in “Connecting in Advanced Connection Mode” on page 77 to connect to the projector.

**Using the Control Bar**

From the control bar, you can access these NS Connection features:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Display projecting computer image]</td>
<td>Displays the Select target projector dialog box.</td>
</tr>
<tr>
<td>![Stop projecting computer image]</td>
<td>Stops projection of computer images while connecting to the projector.</td>
</tr>
<tr>
<td>![Projector projecting computer image]</td>
<td>The projector projects the computer image.</td>
</tr>
<tr>
<td>![Pause projecting computer image]</td>
<td>Pauses projection of computer images. Click again to restart projection.</td>
</tr>
</tbody>
</table>

*note*
The AirPort network name may be different than the AirPort base station name. To check the network name, start the AirPort Admin utility, select your base station, and click Configure. Then click Show All Settings. The network name appears on the AirPort tab.
Clicking one of the buttons on the control bar may cause a submenu to appear above the control bar.

When you’re done, click the arrow in the upper right corner to close the submenu.

**Connecting in Advanced Connection Mode**

1. Click Manual search on the NS Connection screen.

![NS Connection screen](image)
2. Enter the IP address or the projector name for the projector you want to connect to, and click OK.

The Projector is added to the EMP NS Connection screen.

If the search fails to find a projector with the specified IP address, the searching icon turns into a question mark. If this happens, run EasyMP on your projector (see page 48) to check the projector’s IP address, then repeat this step.

3. Click the projector you want to connect to and click the Connect button. If more than one projector is listed, you can select additional projectors and connect to them at the same time.

4. If you are prompted for a keyword, enter the four-digit number displayed on the EasyMP Network screen and click OK.

The computer’s image is transmitted to the projector and appears on the screen. See page 75 for details about using the floating control bar on your computer desktop.

**Enabling Network Security**

The projector includes the following network security options which you can enable for network projection:

- Data encryption
  Encode and transmit data. Even if data is intercepted, it cannot be deciphered. See page 79 to enable encryption.

- Connection limitation (Authentication)
  A user’s name and a password are registered in advance, which means that only the registered wireless port can connect to the network and prevents unauthorized third parties from connecting to the network.
Firewall
Prevents unauthorized computer access by closing ports that are not used. The security functions that can be used with this projector vary depending on the connection mode of the wireless LAN. Use the firewall function provided with your OS.

The security functions that can be used with this projector vary depending on the connection mode:

- **Quick Connection Mode**
  Encrypted communication

- **Advanced Connection Mode**
  Encrypted communication, WEP, WPA-PSK (TKIP), WPA-PSK (AES), EAP-TLS, EAP-TTLS/MD5, EAP-TTLS/MS-CHAPv2, PEAP/MS-CHAPv2, PEAP/GTC, LEAP, EAP-FAST/MS-CHAPv2, EAP-FAST/GTC

### Enabling Data Encryption

1. Click **Set options** on the main screen.

2. Click the **General Settings** tab.

---

**note**
The authentication and firewall features are only effective when the access point for the connection destination supports the same functions.
3. Select the **Encrypt communications** checkbox.

![Image of set options window with encrypt communications checkbox selected]

4. Click **OK**.

**Enabling Network Security Options**

You need to enable network security including WEP, WPA, EAP, LEAP, or PEAP, or firewall settings on your network and on the projector (see page 67). For network setting details, follow the directions from your network administrator.

If using EAP, you need to make settings at the projector that match the authentication server settings. Check with your network administrator for details on RADIUS settings.
Multi-screen Projection

When using Multi-screen display, you can set each projector to display a section of the screen or image, to create a single image spanning a large area. Make sure the projectors are at least 3.6 feet apart to avoid overheating.

Here are some examples:

To set up multi-screen display in NS Connection, follow these steps:

1. Click Use multi-display.

Note

For a Mac, you have to connect a monitor to the computer and use the multi-screen display function. For Windows, even if a monitor is not connected, you can set a virtual display by installing the virtual display driver in EMP NS Connection. See page 172.

For Windows, when the real monitor is connected as a secondary monitor, the image for that screen cannot be projected.

You can adjust each projector’s color to match the images as closely as possible. See page 128.
2. Click Display properties.

3. Drag the monitor icons to arrange the positions of the displays.

4. Close the Display Preferences (Windows) or System Preferences (Mac), when you are done arranging the display numbers.
5. To allocate projectors to each display, choose a number from the menu under Display.

6. Click the Connect button when you are ready to project the image.

7. You can use the Screen Preview button on the NS Connection toolbar to check the image on each screen.

Projecting Video Clips

You can project full-screen MPEG2 video clips with audio in real time (30 frames per second). For best performance, advanced wireless mode, 802.11g, or 802.11a are recommended.

1. Click the Movie Sending Mode button on the NS Connection toolbar.

2. If you are connected to more than one projector, select the one you want to use for the video.

Note

Only MPEG1-Layer2 audio is supported. The maximum supported MPEG2 video resolution is 720 × 480 NTSC or 720 × 756 PAL (without audio).
3. Click the **Select file** button. Locate the MPEG2 video you want to project and click **Open**.

4. Use the standard playback buttons on the screen to start, pause, rewind, and control other video functions.

5. When you're finished projecting video, click the **Close** button on the screen.

---

**note**
The video will be projected on the screen, but will not appear on the host computer.

---

### Using Special Presentation Modes

Your projector provides several features that allow you to show presentation slides to your audience and hide other activity on your laptop. Both work with PowerPoint in Windows and Keynote on Macintosh.

- **Presentation Mode** displays only slides to your audience and hides other activity on your computer.
- **Presenter View** lets you see your notes and slide show controls while projecting your slides.
**Using Presentation Mode**

In Presentation Mode, the projector shows a black screen (or an image of your choice) while you search for files or perform other activities on your laptop. When you start a PowerPoint (Windows) or Keynote (Mac) slide show, the projector shows your slides.

1. Click the **Presentation Mode** button on the NS Connection toolbar. The projector displays a black screen with the Epson logo.
2. Open your presentation in PowerPoint or Keynote.
3. In Keynote, select **Preferences**. Set the Presentation Mode to **Present on secondary display**.
4. In PowerPoint, open the Slide Show pull-down menu and select **Set Up Show**. Set the Multiple monitors box to **Display slide show on Monitor 2**. Then click **OK**.
5. Start your slide show. The projector displays your slides. When you finish your slide show, the projector again displays a black screen.
6. When you want to exit Presentation Mode, click the **Presentation Mode** button on the NS Connection toolbar.

**Using Presenter View**

Presenter View allows you to see your PowerPoint notes and controls on your laptop while projecting only the presentation slides to your audience. Follow these steps to set up and use Presenter View:

1. Make sure you have at least one EPSON Virtual Display enabled.
   
   If you did not enable Virtual Displays when you installed NS Connection, select **EPSON Projector** from **Start > Programs** or **All Programs**. Select **Add-Remove EPSON Virtual Display**, then check **EPSON Virtual Display 1**. If you see a message that the driver has not passed Windows Logo testing, click **Continue Anyway**. Then restart your computer.

2. Launch NS Connection as described on page 73.

---

**note**

If you want to display an image or logo instead of a black screen, you can replace the `image.jpg` file in the EMP NS Connection V2 `Image` folder. In windows, this is located in `C:\Program Files\Epson Projector\EMP NS Connection V2\image`. In MAC OS X, it is located in `Applications\EMP NS Connection V2\image`. Disconnect and then reconnect to the projector after you replace the image.
3. Click Use multi-display, then click Display properties.

4. On the Display Properties screen in Windows, make sure your Epson Projector Virtual Display Driver is selected, then check Extend my Windows desktop onto this monitor and click OK.

In the Mac OS X Displays program, select the Arrangement tab and uncheck the Mirror Displays setting to deselect it.
5. Set your projector to Display 2 (or the Virtual Display Driver you selected in step 4) in NS Connection, then click Connect.

6. Open your presentation in PowerPoint or Keynote.
7. In Keynote, select Preferences.
In PowerPoint, open the Slide Show pull-down menu and select **Set Up Show**.

8. In Keynote, set the Presentation Mode to **Present on secondary display**.

In PowerPoint, set the Multiple monitors box to **Display slide show on Monitor 2** (or the monitor associated with your Epson Virtual Display) and check **Show Presenter View**. Then click **OK**.

9. Start your slide show.

The projector displays the slides, and your laptop displays your notes and controls.
Removing the Wireless 802.11g/b/a Module

Follow these steps to remove the module from your projector.

1. If you’re running NS Connection, click Disconnect on the control bar.

2. Check the access light to make sure it isn’t flashing.

3. If you installed the security screw, remove it. Then pull the module off of the projector.

Connecting to a Wired Network

With the optional Ethernet unit, you can connect the projector to your network and configure it with an IP address.

1. Remove the wireless module, as described above, then insert the Ethernet unit into the projector.

Caution
Never remove the module while the indicator light is green or when projecting wirelessly. You may damage the module or lose data.
2. Connect the projector to your network using a commercially available 100BaseTX or 10BaseT network cable. Connect the cable to the LAN port on the projector.

3. Point the remote control at the projector and press the Power button.

4. Press the EasyMP button on the remote control to select EasyMP as the source.

5. Press the Menu button on the remote control, select the Network menu, then press Enter.

6. Choose To Network Configuration and press Enter.

7. Choose Wired LAN and press Enter.

You see the following screen:

8. Do one of the following:

- If your network assigns addresses automatically, turn on the DHCP setting.
- If your network does not assign addresses automatically, turn off DHCP and enter the projector’s IP Address, Subnet Mask, Gateway Address, and DNS Servers, as needed.
To enter numbers, use the pointer button on the remote control to highlight the number you want to input, then press the Enter button. When you’re finished changing an address in the network menu, highlight Return, then press the Enter button.

When you’re done making all necessary changes, press Menu to exit the menu system.

To connect to the projector with NS Connection using the Quick Connection mode, see page 73. To connect to the projector using Advanced Connection mode, see page 77.

**Using Projector E-mail Alerts**

When this feature is enabled, the projector sends you an e-mail alert if it has any problems.

1. Press the Menu button on the remote control, select the Network menu, then press Enter.
2. Choose To Network Configuration and press Enter.
3. Choose Mail, then press Enter.

You see the following screen:
4. Highlight **On** to receive email notifications, then press **Enter**.

5. Enter the IP address for the SMTP server for the projector.
   You can enter a number from 0 to 255 in each field of the address. However, the following IP addresses cannot be used: 127.x.x.x, 224.0.0.0 to 255.255.255.255 (where x is a number from 0 to 255).

6. Enter the SMTP server’s port number. The default value is 25. You can enter a numeric value from 1 to 65535.

7. Choose one of the **Destination Address** fields, then enter the e-mail address and the contents of the message that you will receive when a problem or warning occurs. You can register up to three addresses. You can enter up to 32 alphanumeric characters for the e-mail address.

8. Select problems or warnings to be notified about by mail.
   When the selected problem or warning occurs, an e-mail message is sent to the specified notification addresses. The subject line of the e-mail is **EPSON Projector**. The e-mail includes the following information:
   - Line 1: The name of the projector where the problem has occurred
   - Line 2: The IP address of the projector where the problem has occurred
   - Line 3: Details of the problem

---

**note**

*If a critical problem develops with a projector which causes it to suddenly stop working, it may not be possible for the projector to send a message.*

*If Standby Mode is set to Network ON in the Extended menu, the projector can still be monitored even if the projector is in standby mode (when the power is off).*
Presenting from a Digital Camera or External Drive

The projector’s EasyMP PC Free feature lets you give presentations from a drive or a digital camera connected to the projector via USB. You can play movies, display graphics, or play a scenario, a format that lets you create your own slideshow using PowerPoint files, JPG image files, and BMP graphics files.

This chapter covers the following:

- Creating a slideshow on the fly
- Presenting image files from a digital camera
- Presenting image files from an external drive
- Creating a scenario
- Transferring your scenario to a memory card
- Presenting scenarios
- Supported file formats

**note**
To create a scenario, you need a USB drive to connect to your computer. Also make sure you’ve installed the EMP SlideMaker software (available for Windows only), as described on page 172.

Depending on the type of card you have, you may also need an adapter to use it with the projector. See page 108.
Creating a Slideshow on the Fly

If you have a folder containing an assortment of images, you can display them as a slideshow.

Displaying the Slideshow

First make sure the images are stored in a folder on the USB drive. Then follow these steps:

1. Use the pointer button on the remote control to highlight the drive containing your images and press Enter.

2. Use the pointer button on the remote control to highlight the folder containing your images and press Enter.
3. From the drop-down menu, use the pointer to select **Play Slideshow** and press **Enter**. The images contained in the folder are presented as a slideshow.

   Use the remote control to run the slideshow as described in the next section.

---

**Controlling Your Slideshow**

While your slideshow is running, use the remote control as follows:

- Press **Enter** or **Page down** to display the next slide or image, or to begin playing a movie.
- Press **Page up** to display the previous slide or image, or to replay a movie.
- Press the appropriate side of the **pointer button** to rotate a slide or image on the screen.
- To exit the slideshow at any point, press the **Esc** button. Press the **Enter** button to confirm that you want to exit.

---

**Changing Timing and Other Settings**

For each folder on the memory card, you can set the display timing for your slides and change several other display settings.

1. Select the folder containing the images for the slideshow settings you want to change and press **Enter**.

2. From the drop-down menu, use the pointer to select **Options** and press **Enter**.
3. Use the \( \odot \) pointer button to select from the following settings. After making a selection, press Enter to save the change.

- **Mode switching**
  Lets you choose the mode to use when presenting slideshows, movies, or images, or editing a scenario on the projector.
  
  In **Guide mode**, a drop-down menu appears whenever you select an item and press Enter.
  
  In **Quick mode**, selecting a scenario, movie, or image file and pressing Enter starts the presentation; selecting a folder and pressing Enter opens the folder. To access the menus in **Quick mode**, press the Esc button.

- **Display order**
  Lets you choose between displaying alphabetically by file name or by image file date.

- **Continuous Play**
  Determines whether to repeat the display of images in the folder.
- **Screen switching time**
  Sets the display time for each image. Choose **No** if you want to change slides manually.

- **Effect**
  Lets you choose from various transitions between slides, such as Dissolve or Wipe.

4. When you're done, highlight **OK** and press **Enter**. Your changes are permanently saved with each folder—even if you turn off the projector or disconnect the drive or camera.

---

**Presenting Image Files From a Digital Camera**

This section explains how to project individual image files on your digital camera using EasyMP PC Free mode and a USB cable connection.

Follow these steps:

1. Connect your digital camera (see page 44).
2. Turn on your digital camera.
3. Turn on the projector and the remote control, if they're not already on.
4. Select EasyMP as the source by pressing the **EasyMP** button on the remote control. If your camera complies with the DCIM standard, you'll see a **DCIM** folder appear on the EasyMP PC Free screen.
5. Use the ⬤ pointer button on the remote control to position the cursor on the folder and press **Enter**.
6. Select **Open Folder** in the drop-down menu. When the folder opens, you see another folder with your manufacturer’s name.
7. Position the cursor on the folder and press **Enter**.
8. Select **Open Folder**. You see your image files when the folder opens.

---

**Note**
Most digital cameras also have the ability to play internal slideshows. Depending on the kind of cable you have, you can connect a camera with a video or A/V out port to the projector’s **Video** or **S-Video** port and transmit your camera’s slideshow directly to the projector. You must press the **Video** or **S-Video** button on the remote control to select the correct signal source. See pages 40 or 41 for details.
9. Position the cursor on the image file you want to project and press Enter.

10. Select View Image. The image is projected on the screen. If you want, you can press a side of the pointer button to rotate the image while you’re viewing it.

To stop viewing images, press the Esc button on the remote control, then select Exit and press Enter.

**Presenting Image Files From an External Drive**

This section explains how to project individual image or movie files from an external hard drive or flash memory drive using EasyMP and a USB connection.

Follow these steps:

1. Connect your external hard drive or flash memory drive (see page 44).
2. Plug in your external hard drive.
3. Turn on the projector and the remote control, if they’re not already on.
4. Select EasyMP as the source by pressing the EasyMP button on the remote control.
5. Use the pointer button on the remote control to position the cursor on the folder where your photos or movies are stored and press Enter.
6. Select Open Folder. You see your image files when the folder opens.
7. Position the cursor on the image file you want to project and press Enter.
8. Select View Image. The image is projected on the screen. If you want, you can press a side of the pointer button to rotate the image while you’re viewing it.

---

*note*

Make sure your camera shows up on your desktop as a drive letter. If it does, it is probably a USB mounted device and will work with the projector software. The EasyMP software does not support TWAIN-compliant digital cameras.
To stop viewing images, press the Esc button on the remote control, then select Exit and press Enter.

Creating a Scenario

A scenario is a combination of images, movies, and/or audio files that you can present from a USB drive. The easiest way to create a scenario is to drag and drop a PowerPoint file on the EMP SlideMaker2 icon on your desktop. This automatically converts the file to a scenario that you can save to the drive. Use this method if you have an existing PowerPoint presentation that you want to transfer to the projector.

If you prefer, you can create a scenario from scratch by combining a selection of PowerPoint slides, other graphics, and even movies (see page 100).

Converting a PowerPoint File to a Scenario

Follow these steps to convert a PowerPoint file to a scenario. Once the scenario is created, you can set up transitions as described on page 105.

1. Make sure the EMP SlideMaker program is closed.
2. Locate the PowerPoint file you want to use in My Computer or Windows Explorer.
3. Drag the file icon on top of the EMP SlideMaker2 icon on your desktop.
4. You see a message that some transitions are not supported. Click Continue.
5. When you see the next message, click Start.

EMP SlideMaker 2 starts and your PowerPoint slides open one-by-one as they are converted. Do not interrupt this process or your PowerPoint file won’t be completely converted.
6. When the scenario is done, click Close. You see the following message:

7. Connect a USB device and browse to the drive, then click OK to transfer your scenario file.

**Creating a Scenario from Scratch**

Use this method when you want to create a scenario from a selection of PowerPoint slides, graphics, or movie files. You’ll need to set up your scenario file and folder, build the scenario, set up transitions, and check the scenario.

**Setting Up the Scenario File and Folder**

1. Double-click the EMP SlideMaker2 icon on your computer’s desktop (or click Start > Programs or All Programs > Epson Projector > EMP SlideMaker2).
You see the EMP SlideMaker 2 screen:

2. Choose **New** from the File menu. You see the scenario Properties dialog box:
3. Type a name for your scenario file and folder that’s easy to remember, using up to eight capital letters and numbers. Then select from the following options:

- The default location for the scenario file and folder is in the \Program Files\EMP SlideMaker2 folder. Click Browse to choose a new location.
- Click Configure BGM(W) to play an audio file during the scenario. A selection screen appears letting you choose a .WAV file. After you select the file you want, click the arrow button to the right of the option to play it.
- The Background Color appears around images that don’t fill the entire screen area. Select a new color, if desired.
- Select the Image Quality for imported PowerPoint slides. Higher-quality images look better on the screen but may take longer to appear.

4. Click OK. You return to the EMP SlideMaker 2 screen.

Continue with the instructions in the next section to build your scenario.

**Building a Scenario from Different Files**

You can build your scenario from any of the following file types, either alone or in combination with other file types:

- PowerPoint slides, version 2000 through 2003 (file names have PPT extension)
- JPEG files (with JPG extension)
- Bitmap files (with BMP or DIB extension)
- Movie files (with MPG extension); must be MPEG 2 (MPEG1 is not supported)
Follow these steps:

1. Use the navigation tools on the left side of the EMP SlideMaker 2 screen to locate the files you want to include in your scenario. PowerPoint, JPEG, bitmap, and movie files appear as icons in the file window.

2. Click the icon for each file that you want to preview. The preview appears in the thumbnail preview window. If you click a PowerPoint icon, thumbnail images are generated for all the slides in the PowerPoint file. If you click a movie file, an illustration of a film strip appears.

**note**

Thumbnail previews for PowerPoint slides will not appear if PowerPoint is not installed on your computer.
3. Drag and drop the files you want to include in your scenario from either the file window or thumbnail window into the scenario window. (You can also double-click a thumbnail to add the file to the scenario.)

To include a whole PowerPoint file (instead of individual slides), drag the PowerPoint icon itself into the scenario window. Dragging an entire file preserves the transitions set in PowerPoint.

4. Continue dragging files into the scenario window to build your presentation. Each slide appears in a numbered cell. The cell background color varies according to the type of file in the cell.

5. If you want, you can make changes to the scenario:
   - To rearrange cells, drag and drop them as necessary within the scenario window.
   - To delete a cell, right-click the cell and select Cut.
   - To check the animation for a slide, click its cell. A section appears at the bottom of the scenario window displaying each animation operation. (Slides using animation have an .EMA extension.)

You can also create transitions between slides, as described in the next section.

---

**note**

Transition effects created in PowerPoint look smoother than those you add with EMP SlideMaker 2.

**note**

Unless you change the transition setting, your slides will automatically advance after 30 seconds.
6. When you’re done, click the **Save** button or choose **Save** from the File menu. Then see page 108 to transfer the scenario to your USB drive.

**Setting Up Transitions**

EMP SlideMaker 2 lets you set your slides to advance manually or automatically after a specified period of time. You can also choose from a variety of transition effects between slides.

1. Click the cell or cells for which you want to set up in the scenario window.

   To select more than one cell, hold down the **Ctrl** key while you click. To select all the cells, choose **Select All** from the Edit menu. Selected cells turn yellow.

2. Right-click the selected cell or cells. The cell menu appears:
3. Click **Cell Properties**. You see this dialog box:

- Click to change slides manually
- Click to change slides automatically
- Select transition effects

4. Choose how you want to advance to the next cell.

- If you want to change slides manually using the remote control, select **On mouse click**.
- If you want your slides to advance automatically, set the timing in the **Automatically after** box. You can set any length of time between 1 and 1800 seconds (30 minutes). Even if you select this setting, you can still change slides manually using the remote control.

**note**
Transition effects look smoother when you create them in the PowerPoint file itself and use that file to create a scenario.

5. To add a transition effect (such as a dissolve, fade, or wipe), select one of the **Animation Effects** settings and choose a **Direction** setting, if applicable.

6. When you’re finished setting up the transition for the selected cell or cells, click **OK**.

7. Click the **Save** button or choose **Save** from the File menu.

Continue with the steps in the next section when you’re ready to transfer your scenario to a USB drive.
Checking Your Scenario

You can play your scenario before you transfer it to a USB drive to make sure it looks and sounds the way you want it to.

1. Use the navigation tools in the folders window to locate the scenario file you want to review. Click the file, then select File > Open to open the scenario.

2. Click Scenario Option(s) > Scenario Preview. The Scenario Preview window displays.

   If the scenario is set to advance automatically (see page 106), it begins to play. If it is set to advance each time you click the mouse, click the play button to go through your slides one by one.

3. Use the controls in the Scenario Preview window to pause, stop, rewind, or fast forward your scenario. When you’re done, close the window.
Transferring Your Scenario to a USB Drive

Once your scenario is saved, you can transfer it to a USB drive. Be sure to use the transfer process described below to ensure that the scenario plays properly:

1. Connect the USB drive.
2. Start EMP SlideMaker 2 (see page 100).
3. Use the navigation tools in the folders window to locate the scenario file you want to review. Click the file, then select File > Open to open the scenario.
4. From the Scenario Option(s) menu, choose Send Scenario. You see a drive selection window:

   ![Drive Selection Window]

   Select your USB drive

5. Choose the drive and click OK.
6. Click OK again to confirm. Your scenario is transferred to the drive.

   Once the scenario is transferred, you see this message about your scenario’s autorun setting:

   ![Autorun Setting Message]

   The autorun setting means that the scenario will start playing whenever the projector is turned on (with the drive connected to the projector).
7. Do one of the following:
   ■ If you don’t want the scenario to run automatically, click Cancel. Skip to step 11 to remove the drive and insert it in the projector.
   ■ If you want it to run automatically, click OK and continue with the following instructions.

You see the Edit Autorun window:

8. To set a scenario to run automatically, select it from the list on the left side of the screen and use the arrow button to move it to the list on the right.

9. Click the Revive box if you want your scenario to repeat continuously. Clear the checkbox if you want it to play only once.

10. When done, click OK.

11. Disconnect the USB device. See your computer’s documentation if you need instructions. If you’re using Windows XP, 2000 or Me, you may first need to click an icon to stop or disconnect the drive.

note
If more than one scenario is set to run automatically, they will play in the order listed on this screen.
Presenting Scenarios

Before you begin, connect the USB drive containing the scenario to your projector, as described on page 93.

The follow these steps to present your scenario:

1. Turn on the projector, if it’s not already on.
   - If your scenario is set to autorun, it will start as soon as the projector warms up.
   - If your scenario is not set to autorun, you need to start it manually. Continue with the following steps.

2. Select EasyMP as the source by pressing the EasyMP button on the remote control. You see a screen like the one below.

![Screen](image)

JPEG files are displayed as thumbnails. Other files or folders are displayed as icons. A scenario icon identifies a scenario file.

3. Use the pointer button on the remote control to highlight your scenario file and press Enter. A drop-down menu appears under the scenario.

4. Use the pointer button to select Play Scenario and press Enter. In a moment, your scenario begins playing.
Controlling Your Scenario

While your scenario is running, use the remote control as follows:

■ Press Enter or Page down to display the next slide or image, or to begin playing a movie.

■ Press Page up to display the previous slide or image, or to replay a movie.

■ Press the appropriate side of the pointer button to rotate a slide or image on the screen.

■ To exit the scenario at any point, press the Esc button. Press the Enter button to confirm that you want to exit.

Note
Even if your scenario is set to change slides automatically, you can still change slides manually as described here.
**Supported File Formats**

The following file types may be projected from a digital camera, external hard drive, or flash memory drive:

<table>
<thead>
<tr>
<th>File Type</th>
<th>Extension</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scenario</td>
<td>.sit</td>
<td>These are scenario files created using the EMP SlideMaker 2 program that is included with the projector.</td>
</tr>
<tr>
<td>Graphics</td>
<td>.bmp</td>
<td>Images with a resolution greater than 1024 x 768 cannot be projected.</td>
</tr>
<tr>
<td></td>
<td>.gif</td>
<td>Images with a resolution greater than 1024 x 768 cannot be projected.</td>
</tr>
<tr>
<td></td>
<td>.jpg</td>
<td>Projection is not possible for CMYK color formats, progressive formats, and images with a resolution in excess of 8192 x 6144.</td>
</tr>
<tr>
<td></td>
<td>.png</td>
<td>Projection is not possible for images with a resolution in excess of 1024 x 768.</td>
</tr>
<tr>
<td>Movie</td>
<td>.mpg</td>
<td>MPEG1 MPEG2-PS If the movie exceeds a maximum size of 720 x 576, or is not in the same form as a DVD (sequence header arranged for each GOP) it cannot be played back. The reproducible audio format is MPEG-1 Layer 2. Linear PCM and AC-3 audio cannot be played back.</td>
</tr>
<tr>
<td></td>
<td>.mov</td>
<td>QuickTime® format Motion JPEG files.</td>
</tr>
<tr>
<td>DPOF</td>
<td>.mrk</td>
<td>For DPOF version 1.10, only files named AUTPLAYx.mrk (where x is a number between 0 and 9) can be projected.</td>
</tr>
</tbody>
</table>

Files with the extension JPEG and MPEG can’t be projected. Rename or save files as JPG or MPG. Files with high compression will not look good. Movie files may not look as good from media with a slow access speed.
Fine-Tuning the Projector

You can use the projector’s on-screen menus to adjust the image, sound, and other features. This chapter covers the following information:

- Using the menu system
- Adjusting the image
- Adjusting signal settings
- Customizing projector features
- Using the projector security features
- Customizing power and operation
- Multi-screen color adjustment
Using the Menu System

You can use the remote control or the projector’s control panel to access the menus and change settings. Follow these steps:

1. To display the menu screen, press the Menu button on the remote control or on the projector.

You see a menu screen similar to the one below:

You see a menu screen similar to the one below:

The menus are listed on the left and the options available for the highlighted menu are shown on the right.

2. Use the ⬆️ pointer button on the remote control (or the navigational buttons on the projector) to scroll through the menu list. When you’ve highlighted the desired menu, press the Enter button to select it.

3. Once you’ve selected the menu, use the ⬆️ pointer button to scroll through the list of options. (Some of the options may be grayed out or unavailable, depending on the selected source.)
4. After highlighting the option you want to adjust, use the 
   ⊙ pointer button to change the setting. In some cases, you may
   have to press the Enter button to view a sub-screen for changing
   the setting.
   ■ Press the left or right side of the ⊙ pointer button to adjust
     a slider bar.
   ■ To select from two or more settings, use the ⊙ pointer
     button to highlight the desired setting and press Enter.

5. After changing the settings, press the Esc button to save your
   changes and return to the previous menu (or press it repeatedly to
   exit the menu system).

   You can also press the Menu button to exit.

**Restoring the Default Settings**

You can use the menu system’s Reset options to restore the factory-
default settings for all the settings listed in a specific menu, or all the
settings in all menus.

To restore the settings in a specific menu, enter the menu whose
settings you want to change, select Reset, and confirm as needed.
(The example below shows how to reset the Image menu.)

To restore all the projector settings to their factory-default values,
select the Reset menu, highlight Reset All, and press Enter.

---

**note**

When you select Reset All in the Reset menu, it does
not reset the Computer Input, Video Signal, User’s
Logo, Language, or Lamp settings.
Adjusting the Image

You can use the Image menu to adjust the brightness, sharpness, color, tint, and contrast.

1. Press the Menu button on the projector or remote control and select the Image menu. You see the Image menu screen.

2. Use the ▼ pointer button to highlight the desired option, then adjust it as needed:

- **Color Mode**
  
  Lets you quickly adjust the color and brightness for various environments. Use either the remote control or the Color Mode setting in the Image menu. You can save a different setting for each source. Select from these settings:

  **Photo:** For vivid, high-contrast still images in a bright room.

  **Sports** *(video, S-video, or composite video only):* For vivid TV images projected in a bright room.

  **Presentation:** For computer presentations (the default when projecting from a computer with analog video).

  **Theatre:** For optimizing movie images with increased contrast.

  **Game:** For increased brightness when playing video games or watching TV in a bright room. Emphasizes dark gradations.

  **sRGB:** For matching the color palette of standard sRGB computer displays.
Blackboard: For projecting accurate colors on a green chalkboard (adjusts the white point).

Customized: For manual color adjustment. (See below.)

- **Brightness**
  Lightens or darkens the overall image.

- **Contrast**
  Adjusts the difference between light and dark areas.

- **Color Saturation (video only)**
  Adjusts the color depth of the image.

- **Tint (video only)**
  Adjusts the balance of green to magenta in the image (available only for component video or NTSC signals).

- **Sharpness**
  Adjusts the sharpness of the image.

- **Color Adjustment**
  Adjusts the color values. For **Customized** color mode, select **RGBCMY** to adjust individual red, green, blue, cyan, magenta, and yellow hue and saturation values. For other color modes, **RGB** may be selected to adjust red, green, and blue hue and saturation values. (Not available if **sRGB** is selected as the Color Mode setting.)

- **ABS Color Temp.**
  Sets a color temperature between 5000 and 10000 °K. (Not available if **sRGB** is selected as the Color Mode setting.)

### Six-Axis Color Adjustment

For special projection material, such as high-quality photographs or artwork, you can adjust the hue and saturation for six different color axes.

1. Follow the instructions on page 116 to open the Image menu and select **Color Mode**.

2. Press the **Enter** button to select **Customized**, then press **Esc** to return to the Image menu.

---

**note**
The **Brightness** setting changes the opacity of the projector's LCD panels. You can also change the lamp's brightness. Select **Brightness Control in the Setting menu, then choose High or Low (the default setting is High).**
3. Select Color Adjustment and press Enter. You see hue and saturation controls on the screen for six colors: RGBCMY (red, green, blue, cyan, magenta, and yellow).

4. Select the color axis you want to adjust and press Enter. You see color controls for hue and saturation.

   Hue changes the balance of color, and saturation changes the strength of the color.

5. Use the pointer button to adjust the hue and saturation. You see the adjustments reflected on the screen. When you are satisfied with the color, press Esc.

6. Repeat steps 4 and 5 for each color axis you want to adjust.

   You may need to readjust the color as the lamp in your projector changes over time.

---

**Adjusting Signal Settings**

Although the projector normally detects and optimizes the input signal automatically, you can use the Signal menu to make manual adjustments. In addition to changing the position of the projected image, you can correct tracking and sync for computer images, or change the aspect ratio to widescreen format for video images.

1. Press the Menu button and select the Signal menu.

   You see a screen similar to one of those below. (The settings will be different depending on the source you are projecting from.)
2. Use the pointer button to highlight the desired option, then adjust it as needed:

- **Auto Setup**
  Leave this setting **On** to automatically optimize the computer image. Turn it off if you want to save adjustments you have made to the video settings.

- **Tracking**
  Adjust this value to eliminate vertical stripes in the image.

- **Sync**
  Adjust this value if the image appears blurry or flickers.

- **Progressive**
  Turn this setting **On** to convert composite video signals into progressive signals (best for still images). Leave the setting **Off** for moving images.

- **Position**
  If the image is slightly cut off on one or more sides, it may not be centered exactly. Select this setting and use the pointer button to center it.

- **Computer Input**
  If the colors don’t look right on the **Auto** setting, select the setting for the type of equipment you’ve connected to the **Computer/Component Video** port:
    - **RGB**: For a computer connection.
    - **Component Video**: For a video player that outputs a component video signal.

- **Video Signal**
  Leave this setting at **Auto** unless you are using a 60-Hz PAL system (then select **PAL60**).

- **Resize**
  Choose an aspect ratio of either **4:3** or **16:9**. **Normal** is the default setting for a computer connection.

---

**tip**
Before adjusting tracking or sync, fill the screen with an image containing fine detail. For example, in Windows you can select a pattern to appear as your desktop background. If this option isn’t available, try projecting black text on a white background.
Customizing Projector Features

You can use the Settings menu to lock the buttons on the projector, adjust audio volume, and customize several other features.

- **Keystone**
  Squares up the shape of the image after the projector has been tilted upward. If you notice lines or edges looking jagged after adjusting the shape, decrease the Sharpness setting (see page 116).

- **Auto Keystone**
  Automatically compensates for keystone distortion when the projector is tilted upward. This feature is available only when the projector is set for front projection (it is enabled by default).

- **Operation Lock**
  Lets you disable all of the buttons on the projector except the Power button. See page 126 for more information.

- **Pointer Shape**
  Lets you choose from three alternative pointer shapes. See page 34 for more information.

- **Brightness Control**
  Lets you select from two levels of brightness. The Low setting reduces power consumption and noise, and extends the lamp’s operating life.

- **Volume**
  Raises or lowers the volume of the projector’s speaker.

**note**
You can also adjust the volume using the remote control.
EasyMP Audio Out
Let’s you output sound from EasyMP scenarios (.wav files) or MPEG files to external speakers with built-in amplifiers. Connect the speakers as shown on page 46.

Using the Projector Security Features

To prevent unauthorized use of the projector, you can do the following:

- Assign a password; this can be disabled for a set period if you want to loan the projector to someone.
- Create an identifying user logo that is displayed at startup and/or when the A/V Mute button is pressed. See page 124.
- Disable the projector’s buttons; this is useful, for example, if you’re projecting in a classroom and you want to ensure that no one touches the projector’s buttons while you’re using the remote control. See page 126.
- Lock the network configuration settings. See page 123.

If you create a user’s logo for the projector, you can set up the logo so it is displayed as the startup screen and/or AV/Mute screen. Unauthorized users cannot turn it off or change it. This feature is intended to discourage theft and provides a way to identify the projector should it be stolen.

Enabling Password Protection

To prevent unauthorized use, you can assign the projector a password. If you do, a screen will appear requesting the password whenever the projector is plugged in and turned on. If an incorrect password is entered three times in succession, the projector’s operation is locked and the power cord must be disconnected and reinserted to redisplay the password screen. If an incorrect password is entered thirty times in succession, the user must contact Epson to unlock the projector.

Note

It’s a good idea to write down your password.

If you leave the projector plugged in, the Password Protect Release screen will not appear. You only need a password if you unplug and reconnect the power cable.
The default setting for the Password Protect function is Off. Follow these steps to turn password protection on:

1. Press the Freeze button on the remote control for about five seconds.
   
   You see this screen:

   ![Password Protect Screen]

   2. Use the pointer button to set Power On Protect to On. Then press Enter.

   3. Press Esc.

   4. Select Password and press Enter.

   5. When you see a message asking if you want to change the password, select Yes and press Enter.

   6. Hold down the Num button on the remote control and use the numeric keypad to enter a four digit password. (The default setting is 0000.)

   7. When you see a confirmation message, reenter the password. Then press the Menu button to exit the screen.

   8. Press the Num button on the remote control to deactivate the numeric keypad.

   9. If you want to disable the password temporarily, select Timer and press Enter. Then hold down the Num button while you use the numeric keypad to enter the number of hours (from 0 to 9999) that you want the password feature disabled. If you want the projector to request the password every time it is turned on, set the timer to 0H.

caution

If you lose the remote control, you will not be able to enter the password. Keep the remote control in a safe place at all times.
The countdown for the elapsed time begins as soon as you close the Password Protect menu. (You can check the elapsed time in this menu next to Time elapsed.)


When this feature is on, the logo appears whenever you turn on the projector (if the Startup Screen is enabled in the Extended menu; see page 124). It also appears when you press the A/V Mute button (if you selected the Logo for the A/V Mute setting under Display in the Extended menu). None of the User’s Logo features in the Extended menu can be changed when the User’s Logo Protect function is enabled.


When this feature is on, none of the network settings on the Configuration menu can be changed.

**Starting the Projector with a Password**

When the password function is enabled, you see this screen when you plug in and turn on the projector:

Hold down the Num button on the remote control and use the numeric keypad to enter the four digit password.

The password screen closes, the numeric keypad is automatically deactivated, and projection begins.
If the password is not correct, you see a message prompting you to re-enter the password. If you enter an incorrect password three times in succession, you see the message The projector’s operation will be locked. Request code xxxxx and the projector switches to standby mode for approximately 5 minutes. Write down the request code. Then disconnect the projector’s power cord from the electrical outlet, reconnect it, and turn the projector back on.

When you see the Password Protect Release screen again, you can try to enter the correct password.

If you enter an incorrect password 30 times in succession, the projector remains locked and you must contact Epson to unlock it.

If you have forgotten the password, contact Epson with the request code number that appears in the Password Protect Release screen for assistance. See “Where To Get Help” on page 168.

**Creating Your Own Startup Screen**

You can transfer any image from your computer or video source to the projector and then use it as your startup screen. You can also use it as the screen displayed when the projector is not receiving a signal or when you press the A/V Mute button. The image can be a company logo, slogan, photograph, or any other image you want to use.

**Capturing the Image**

Start by displaying the image you want to use from either a computer or video source, such as a DVD player or digital camera. Then follow these steps to capture the image and transfer it to the projector:

1. Press the Menu button on the remote control, highlight the Extended menu, and press Enter.

3. When you see a message asking Choose this image as the user’s logo?, select Yes and press Enter. A selection box displays over the image.

4. Use the pointer button to select the area of the image you want to use. Then press Enter.

5. When you see the message Select this Image?, highlight Yes and press Enter.

6. Use the arrow buttons to select a zoom rate (display size) and press Enter.

7. When the message Save this image as the user’s logo? appears, select Yes and press Enter. Saving the logo may take a few moments. Do not use your projector, remote control, or video source while the logo is being saved.

8. When you see the message Completed, press Esc to return to the menu screen.
**Choosing When to Display the Image**

After your image is saved, it is automatically set as the startup screen. You can also set it to display as the screen you see when there’s no signal or when you press the A/V Mute button (see page 30).

1. Press the **Menu** button, highlight the **Extended** menu, and press **Enter**.
2. Select **Display** and press **Enter**.
3. Highlight **Display Background** (for when there is no signal) or **A/V Mute**, and press **Enter**.
4. Select **Logo** and press **Enter**.
5. When you’re finished, press **Esc** to exit.

**Disabling the Projector’s Buttons**

When you enable the Operation Lock function, you can lock all the projector’s buttons, or all buttons except the **Power** button.

1. Press the **Menu** button, highlight the **Settings** menu, and press **Enter**.
2. Select **Operation Lock** and press the **Enter** button.
3. Select **Full Lock** (to lock all projector buttons) or **Partial Lock** (to lock all buttons except the **Power** button) and press **Enter**.
4. Select **Yes** and press **Enter** to confirm the setting.
5. Press the **Menu** button to exit.

*note*

Press the Enter button on the projector’s control panel for 7 seconds to disable the Operation Lock function.
Customizing Power and Operation

You can use the Extended menu to customize the way the projector displays images, enable quick startup, turn sleep mode on or off, and customize other projector operations.

- **Display**
  Use this setting to turn off the display of messages, change the background color, enable logo display, or turn off the startup screen display.

- **User’s Logo**
  Create a custom startup screen, as described on page 124.

- **Projection**
  Select **Front** (to project from the front of a screen and right side up), **Front/Ceiling** (when the projector is mounted upside-down from the ceiling), **Rear** (to project from behind onto a transparent screen), or **Rear/Ceiling** (to project from behind onto a transparent screen when the projector is mounted upside-down from the ceiling).

  When you select one of the Ceiling projection methods, the projector requires a 10-second cool-down after you turn it off. You need to wait until you hear the projector beep before unplugging it.

- **Operation**
  Enable **Direct Power On** if you want to have the projector start when the power cable is connected (without pressing the Power

---

**note**

If Direct Power On is enabled, the power cable is connected, and a power outage occurs, the projector will start when the power is restored.

Do not use the projector at altitudes above 7500 ft (2,286 m).
button). Enable **Sleep Mode** if you want to have the projector turn off automatically if it is idle (and no signal is received) for 30 minutes or when the A/V Mute Slide is Closed. Enable **High Altitude Mode** when you are using the projector above 4900 ft (1500 m).

- **Standby Mode**
  Select **Network On** to enable the projector to be monitored over a network when it is in standby mode (the power light is orange).

- **USB Type B**
  Select **Easy MP** to project your computer’s display through the projector’s Type B USB port. Choose **Link21L** if you want to be able to use the remote as a wireless mouse for a USB-connected computer. See page 38 for more information.

- **Link 21L**
  This setting is available only if you select **Link21L** for the **USB Type B** setting. Select **Off** if you want to use the remote as a wireless mouse for a USB-connected computer. See page 38 for more information.

- **Multi-screen**
  Enable this option if you are using the multi-screen feature to project from one source (one image) using multiple projectors (see page 81). Select **Screen ID** to define individual screen IDs. Choose **Image Correction** then choose an adjustment: **Brightness Correct** to adjust the brightness of each display, **Color Correct** to adjust the balance between red and green, or blue and yellow. See below for more information about multi-screen color adjustment.

- **Language**
  Select from nine languages to be used for the projector menus.
**Multi-screen Color Adjustment**

When you use the multi-screen feature to project from one source (one image) using multiple projectors (as described on page 81), you can match the color between projectors. For each screen, you can set five levels of brightness and color correction.

To match the display colors as closely as possible, first make sure that all the projectors are set to the same color mode. See page 116 for instructions. Then follow these steps:

1. Press the **Menu** button and open the Extended menu.
2. Select **Multi-screen** and press **Enter**.
3. Press **Enter** again to select **Screen ID**.
4. Assign an ID number to each screen. Once you assign the number, you can select an individual screen by pressing the **Num** button on the remote control while pressing the number button that corresponds to the screen number.
5. Select **Image Correction** and press **Enter**.
6. Start by adjusting the brightness of Level 1 for two projectors. Match the darker projector to the lighter one. Press **Enter** to see the effects of your adjustments.
7. Next, adjust the brightness of Level 5 for the same two projectors. Match the brighter projector to the darker one.
8. Adjust and match the brightness of Levels 2, 3, and 4.
9. Adjust and match the G/R color correction for all levels. Then adjust and match the B/Y correction for all levels.
10. If you are using three or four projectors, repeat steps 6 through 9 to match projector 3 to projector 2, then match projector 4 to projector 3.
Fine-Tuning the Projector
Managing Projectors

The software included with your projector lets you monitor and control your projectors from a remote computer:

- Use EMP Monitor (available for Windows only) to see your projectors’ status, switch image sources, and control basic settings.
- Use the mail notification function to receive e-mail alerts about possible problems.

You can also use NS Connection to register up to 16 projectors as a group. This allows you to provide quick and easy access to these projectors from other computers.

To use the software to manage your projectors, first install EMP Monitor as described on page 172. If you plan to create projector groups, also install EMP NS Connection. Then connect and configure each projector you want to monitor. You can connect the projector wirelessly in Access Point mode or over a wired network (as described on page 57).

This chapter covers the following information:

- Monitoring and controlling your projector with EMP Monitor
- Using e-mail alerts to warn you of problems
- Understanding notification messages
- Using a browser to monitor the projector
Using EMP Monitor

EMP Monitor lets you use a remote computer to manage your projectors, whether connected wirelessly or over a wired network. It lets you easily turn the projectors on or off (together or individually), switch image sources, and check their status.

Before using EMP Monitor, make sure you’ve installed the software (available for Windows only) as described on page 172. The computer you’re using to monitor the projector should already be connected to your network.

Opening and Closing EMP Monitor

To start EMP Monitor, click Start > Programs or All Programs > EPSON Projector > EMP Monitor.

If you’ve added the program to the Startup programs folder, then it may already be open. If so, click the icon in the system tray on the lower-right corner of your screen to display the EMP Monitor window:

To close EMP Monitor, select Exit from the File menu or right-click the program icon shown above, then select Exit.
Registering a Projector

Before you can monitor a projector, you have to register it. Follow these steps to automatically search for your projector(s). To manually register your projector(s) with EMP Monitor, refer to the on-screen Operation Guide.

1. Open EMP Monitor as described above. You see this screen:

2. Select Edit > New > Projector (automatic search).

You see this screen:
3. Click **Search** to locate projectors currently operating on the network.

Any projectors found on the network are listed as shown below:

![Projector List]

4. Select the projector you want to add by clicking its name, then click the **Edit** button.

You see this screen:

![Edit Projector Screen]
5. Enter a Display name, select a Parent group, if necessary, enter a Monitor Password, if necessary, and a Description for the projector. Then click the Register button.

To register additional projectors with EMP Monitor, repeat steps 2 through 5.

6. When you’re done adding projectors, click Cancel.

You see a screen with a list of all registered projectors:

![List of Registered Projectors]

**Monitoring Your Projectors**

The EMP Monitor screen lets you monitor your projectors using the Status, Video Source, and Error icons shown below. This lets you see which projectors are currently being used, from which source (or port) they are projecting an image, and if a problem occurs.

For detailed status information, right-click the projector in question and click Property.

**note**

To delete a projector from the list, right-click the projector name, and click Delete.

**note**

To monitor a projector when it’s in standby mode (plugged in but not turned on), you must select Network On as the Standby Mode setting in the projector’s Extended menu (see page 128).
The following tables describe the status icons shown on the EMP Monitor screen.

**Group status icons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>No warnings or problems. All projectors in the group are operating normally.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>Warning or problem. A projector in the group has a warning or problem.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>Monitoring disabled. Right click the icon and select Monitoring Enabled to begin monitoring the group.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Icon" /></td>
<td>Data is currently being updated.</td>
</tr>
</tbody>
</table>

**Type status icons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image5.png" alt="Icon" /></td>
<td>No warnings or problems.</td>
</tr>
<tr>
<td><img src="image6.png" alt="Icon" /></td>
<td>Warning or problem.</td>
</tr>
<tr>
<td><img src="image7.png" alt="Icon" /></td>
<td>Monitor Password error. No monitor password was entered when the projector was registered, or an incorrect password was entered.</td>
</tr>
<tr>
<td><img src="image8.png" alt="Icon" /></td>
<td>Monitoring disabled. Right-click the icon and select Monitoring Enabled to begin monitoring the projector.</td>
</tr>
<tr>
<td><img src="image9.png" alt="Icon" /></td>
<td>Data is currently being updated.</td>
</tr>
<tr>
<td><img src="image10.png" alt="Icon" /></td>
<td>Network error (for example, the projector is not connected to the network, or power cable is disconnected). You may also see this error if Network Off is selected in Standby Mode.</td>
</tr>
<tr>
<td><img src="image11.png" alt="Icon" /></td>
<td>Network error (Esc/VP.net communication error).</td>
</tr>
</tbody>
</table>

---

*note*

To create projector groups in EMP Monitor, refer to the on-screen Operation Guide.

---

136 Managing Projectors
### Power status icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Status Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>💡</td>
<td>The projector is powered on and its status is normal.</td>
</tr>
<tr>
<td>☀</td>
<td>The projector is powered off and its status is normal.</td>
</tr>
<tr>
<td>🚨</td>
<td>The projector is powered on and its status is abnormal.</td>
</tr>
<tr>
<td>⚠️</td>
<td>The projector is powered off and its status is abnormal.</td>
</tr>
</tbody>
</table>

### Temperature level status icons

<table>
<thead>
<tr>
<th>Temperature Level</th>
<th>Status Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌡️amateurs</td>
<td>The projector’s internal temperature is normal (low).</td>
</tr>
<tr>
<td>🌡️</td>
<td>The projector’s internal temperature is normal (medium).</td>
</tr>
<tr>
<td>🌡️</td>
<td>The projector’s internal temperature is normal (high).</td>
</tr>
<tr>
<td>🌡️</td>
<td>The projector’s internal temperature is high (high-temperature warning).</td>
</tr>
<tr>
<td>🌡️</td>
<td>The projector’s internal temperature is too high (internal temperature error). The projector is turned off automatically.</td>
</tr>
</tbody>
</table>

### Error status icons

<table>
<thead>
<tr>
<th>Error</th>
<th>Status Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🕵️ Target</td>
<td>Lamp life warning. The lamp is nearing the end of its life.</td>
</tr>
<tr>
<td>🚨</td>
<td>High-temperature warning. The projector is getting too hot but continues to operate.</td>
</tr>
<tr>
<td>🔄</td>
<td>Replace air filter.</td>
</tr>
<tr>
<td>🚫</td>
<td>No air filter. The air filter is not installed or installed incorrectly.</td>
</tr>
<tr>
<td>🚫</td>
<td>Low air flow. The air filter needs to be cleaned or replaced.</td>
</tr>
</tbody>
</table>
### Error status icons (continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="icon1.png" alt="Icon" /></td>
<td>Air flow sensor error. There is a problem with the projector’s air flow sensor; contact Epson as described on page 168.</td>
</tr>
<tr>
<td><img src="icon2.png" alt="Icon" /></td>
<td>Lamp cover door open. Close the lamp cover door.</td>
</tr>
<tr>
<td><img src="icon3.png" alt="Icon" /></td>
<td>Lamp out. The lamp has reached the end of its life.</td>
</tr>
<tr>
<td><img src="icon4.png" alt="Icon" /></td>
<td>Lamp failure at power on. The lamp has reached its end of life or is installed incorrectly.</td>
</tr>
<tr>
<td><img src="icon5.png" alt="Icon" /></td>
<td>High internal temperature error. The projector is turned off automatically.</td>
</tr>
<tr>
<td><img src="icon6.png" alt="Icon" /></td>
<td>Internal (system) error. Contact Epson as described on page 168.</td>
</tr>
<tr>
<td><img src="icon7.png" alt="Icon" /></td>
<td>Fan error. Contact Epson as described on page 168.</td>
</tr>
<tr>
<td><img src="icon8.png" alt="Icon" /></td>
<td>Sensor error. Contact Epson as described on page 168.</td>
</tr>
<tr>
<td><img src="icon9.png" alt="Icon" /></td>
<td>Other error. Contact Epson as described on page 168.</td>
</tr>
</tbody>
</table>

See page 153 for recommended solutions to problems.
Controlling Your Projectors

The control buttons in the upper-right let you turn the projector on and off and select video sources. (Hold the mouse pointer over a button to see a description of its meaning.) Make sure you’ve selected the projector you want to operate (with the mouse pointer) before clicking one of the buttons.

note
To turn on a projector when it’s in standby mode (plugged in but not projecting), you must have selected Network On as the Standby Mode setting in the projector’s menu system (see page 128).
Configuring the Monitoring Interval

If you need to have the most current status information about your projectors, click the Refresh button in EMP Monitor.

To select how often EMP Monitor checks the status of projectors, follow the steps below:

1. From the Tool menu, select Environment Setup. You see this screen.

2. Enter the desired Update interval and click OK.

\begin{quote}
\textbf{note}\n
If you want EMP Monitor to run whenever you start your computer, click Register at startup.
\end{quote}
Using E-mail Alerts

You can set up e-mail alerts to warn you of problems with the projector. Follow the steps below:

1. From the Tool menu, select Mail notification function. You see this screen:

   ![Mail notification function screen](image)

2. Turn the Mail notification function setting On.
3. Enter the IP address and port number of your network’s SMTP (outgoing) mail server.
4. Enter the Sender (projector) mail address.
5. Enter up to three e-mail addresses to send alerts to in the Recipient mail address boxes.
6. Click the Notification event buttons to select the conditions under which an e-mail alert will be sent.
7. When you’re done, click the OK button to close the Set mail notification function window.
Understanding the Notification Messages

If a projector experiences a problem, EMP Monitor sends an e-mail message to each of the addresses you entered in the Set mail notification function window.

The subject line of the message includes the projector’s display name, shown in EMP Monitor, and the warning/error.

The body of the message contains:

- The projector’s display name in EMP Monitor
- The error/warning message

The problem descriptions are similar to the errors listed on page 137. When the problem has been fixed, EMP Monitor sends a message indicating the problem has been resolved.

Using a Browser to Monitor the Projector

If your projector is connected to a network, you can use a standard web browser to monitor and control it.

1. Make sure that the projector is set up for your wireless network, as described on page 50. (Standby Mode in the Extended menu should be set to Network On to monitor the projector in standby mode.)

2. Open your web browser and enter the IP address of the projector you want to monitor in the browser window.

   If you’re not sure what the address of the projector is, turn the projector on and select Wired LAN or Wireless LAN from the Network menu to display the IP address of the projector.
You see a login screen.

![Login Screen]

3. Do one of the following:

- If you didn’t set a Web control password in the projector’s Network menu, click OK.
- If you set a Web control password in the projector’s Network menu, enter it in the Password box, then click OK.

You see this screen:
4. Select one of the menu options listed on the left, then change any of the settings as needed. These settings correspond to those found in the projector’s menu system.

You cannot change the following settings using a web browser:

- **Pointer** in the Settings menu
- **User’s Logo** in the Extended menu
- **Reset All, Reset Air Filter Time, or Reset Lamp Hours** in the Reset menu

Use the controls at the bottom of the screen just as you would the corresponding remote control buttons. Choose a source, stop the action, turn off the picture and sound, or turn the projector’s power on or off.
Maintaining the Projector

Your projector needs little maintenance. All you have to do is keep the lens clean. You may also need to clean the air filter and vent. A clogged air filter or vent can block ventilation needed to cool the projector.

The only parts you should replace are the lamp and air filter. If any other part needs replacing, contact your dealer or a qualified servicer.

This chapter covers the following:

- Cleaning the lens
- Cleaning the projector case
- Cleaning the air filter and vent
- Replacing the lamp and air filter
- Transporting the projector

**warning**

Before you clean any part of the projector, turn it off and unplug the power cord. Never open any cover on the projector, except the lamp cover. Dangerous electrical voltages in the projector can injure you severely. Do not try to service this product yourself, except as specifically explained in this User’s Guide. Refer all other servicing to qualified service personnel.
Cleaning the Lens

Clean the lens whenever you notice dirt or dust on the surface.

Use a canister of compressed air to remove dust.

To remove dirt or smears on the lens, use lens-cleaning tissue. If necessary, moisten a soft cloth with lens cleaner and gently wipe the lens.

Cleaning the Projector Case

Before you clean the case, turn off the projector and unplug the power cord.

- To remove dirt or dust, wipe the case with a soft, dry, lint-free cloth.
- To remove stubborn dirt or stains, moisten a soft cloth with water and a neutral detergent. Then wipe the case.

caution

Do not use wax, alcohol, benzene, paint thinner, or other chemical detergents. These can damage the case.
Cleaning the Air Filter and Vent

Your projector includes an air filter to ensure the best performance. If dust collects on the air filter (on the bottom of the projector) or vent (on the front of the projector), clean them as described below. Dust clogs prevent proper ventilation and can cause overheating and damage the projector.

Follow these steps:

1. Turn off the projector. Wait for the Power light to stop flashing, then unplug the power cord.

2. To clean the intake vent and filter, use a small vacuum cleaner designed for computers and other office equipment. If you don’t have one, gently clean the vent with a soft brush (such as an artist’s paintbrush).

   You can remove the air filter to clean both sides.

3. If the dirt is difficult to remove or the filter is broken, replace the filter as described on page 150. Contact your dealer or call Epson at 800-GO-EPSON (800-463-7766) to obtain a new filter.

---

note
To order replacement air filters, request part number V13H13408. See page 13 for ordering information.
Replacing the Lamp and Air Filter

The life span of the projection lamp is about 2000 hours if Brightness Control in the Setting menu is set to High (default), and 3000 hours if Brightness Control is set to Low.

It is time to replace the lamp when:

- The projected image gets darker or starts to deteriorate.
- The message Replace the lamp appears on the screen when the lamp comes on and the lamp warning light \( \text{\large \textcolor{red}{\text{X}}} \) flashes orange. To maintain projector brightness and image quality, replace the lamp as soon as possible.
- The lamp warning light \( \text{\large \textcolor{red}{\text{X}}} \) flashes red (the lamp is burnt out).

Contact your dealer or call Epson at 800-GO-EPSON (800-463-7766). Request part number V13H010L38.

Follow these steps to replace the lamp and air filter:

1. Turn off the projector.
2. When the Power light stops flashing, unplug the power cord.
3. Let the projector cool for at least an hour (if it has been on). The lamp is extremely hot immediately after use.

**note**

When you get a replacement lamp for your projector, you should replace the filter.

To check how long the lamp has been in use, see page 157.

Turn off this product when not in use to prolong the life of the projector.

**warning**

Let the lamp cool fully before replacing it.

In the unlikely event that the lamp has broken, small glass fragments may be present and should be removed carefully to avoid injury.

If the lamp is used after the replacement period has passed, the possibility that the lamp may break increases. When a lamp replacement message appears, replace the lamp with a new one as soon as possible, even if it is still working.
4. Loosen the lamp cover screw (you don’t need to remove it). Then slide the lamp cover to the side and lift it off of the projector.

5. Loosen the two screws holding the lamp in place (you can’t remove them).

6. Hold the lamp as shown and pull it straight out.

7. Gently insert the new lamp. (If it doesn’t fit easily, make sure it is facing the right way.)

---

**note**

The lamp(s) in this product contain mercury. Please consult your state and local regulations regarding disposal or recycling. Do not put in the trash.
8. Push down the corner marked PUSH until it snaps in.

9. Once the lamp is fully inserted, tighten its screws.

10. Replace the lamp cover, then tighten its screw.

11. Slide out the air filter on the bottom of the projector and remove it.

12. Slide in the new air filter until it clicks in place.

13. Reset the lamp timer as described in the next section.
**Resetting the Lamp Timer**

After you replace the lamp, you need to reset the lamp timer using the projector’s menus.

1. Press the **Menu** button on the remote control or on the projector’s control panel. You see the main menu.

2. Use the ⤵️ pointer button on the remote control (or the arrow buttons on the projector) to highlight **Reset**, then press **Enter**.

   You see this screen:

   ![Menu Screen](image)

3. Select **Reset Lamp Hours** and press **Enter**.

4. When you see the prompt, select **Yes** and press **Enter**.

5. When you’re finished, press **Esc** or **Menu** to exit the Menu system.
Transporting the Projector

The projector contains many glass and precision parts. Follow these guidelines to prevent damage:

- When shipping the projector for repairs, use the original packaging material if possible. If you do not have the original packaging, use equivalent materials, placing plenty of cushioning around the projector.

- When transporting the projector a long distance, first place it in a hard-shell shipping case, then pack it in a firm box with cushioning around the case. (An optional case is available from Epson; see page 13.)

- Close the A/V Mute slide (lens cover) to protect the lens.

\[\text{Note}\]

Epson shall not be liable for any damages incurred during transportation.
Solving Problems

This chapter helps you solve problems with your projector, and tells you how to contact technical support for problems you can’t solve yourself. The following information is included:

- Using the projector’s on-screen help system
- What to do when the projector’s status lights flash
- Solving projector operation problems
- Solving problems with the image or sound
- Solving network problems
- Solving EasyMP problems
- Solving problems with the remote control
- Contacting technical support
Using On-Screen Help

If the image doesn’t look right or your audio isn’t working, you can get help by pressing the blue ? Help button on top of the projector or on the remote control. The following choices are available:

- Problems with image
- There is no sound
- Select a different language

Follow these steps to get help:

1. Press the blue ? Help button on the remote control or on the projector.

You see the Help Menu.

2. Use the pointer button on the remote control or the navigational buttons on the projector to highlight menu items.

3. Press the Enter button on the remote control or on the projector to select the menu item.

4. To exit the help system, press the ? Help button.

If none of the suggestions solve your problem, see additional solutions to problems in the following sections.
Checking Projector Status

If your projector isn’t working correctly, first turn it off, wait for it to cool (the Power light stops flashing orange), and unplug it. Then plug the power cord back in and turn on the projector. If this doesn’t solve the problem, check the lights on top of the projector.

What To Do When the Lights Flash

The lights on top of the projector indicate the projector’s status.

Refer to the following table for a complete description of the projector’s status lights:

<table>
<thead>
<tr>
<th>Light</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orange</td>
<td>The projector is in sleep or standby mode. You can unplug it or press the Power button to turn it on.</td>
<td></td>
</tr>
<tr>
<td>Flashing green</td>
<td>The projector is warming up. Wait for the image to appear.</td>
<td></td>
</tr>
<tr>
<td>Green</td>
<td>The projector is operating normally.</td>
<td></td>
</tr>
<tr>
<td>Flashing orange</td>
<td>The projector is cooling down. You can’t turn it back on (and you should not unplug it) until the light stops flashing and remains orange.</td>
<td></td>
</tr>
<tr>
<td>Red</td>
<td>There is a problem with the projector. Check the other two lights and the information on page 156 to diagnose the problem.</td>
<td></td>
</tr>
</tbody>
</table>
### Status lights (continued)

<table>
<thead>
<tr>
<th>Light</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Light" /></td>
<td>Flashing red</td>
<td>There is a problem with the fan or temperature sensor. The air filter or vent may be clogged. Clean them or replace the air filter as described on page 147. If this does not resolve the problem, stop using the projector, disconnect the power cable, and contact Epson as described on page 168.</td>
</tr>
<tr>
<td><img src="image" alt="Light" /></td>
<td>Flashing orange</td>
<td>Rapid cooling is in progress. Although this is not an abnormal condition, projection will stop automatically if the temperature rises higher. Make sure there is plenty of space around and under the projector for ventilation, and that the air filter and vents are clear.</td>
</tr>
<tr>
<td><img src="image" alt="Light" /></td>
<td>Red</td>
<td>The projector is overheating, which turns the lamp off automatically. Wait until the cooling fan stops, then unplug the power cord. Plug the power cord back in and press the ( \text{Power} ) button. Make sure the room temperature is not above 95 °F (35 °C), and there is plenty of space around and under the projector for ventilation. The air filter or vent may be clogged. Clean them or replace the air filter as described on page 147. If the projector continues to overheat after you clean the air filter, the problem may be caused by damage to the cooling fan or temperature sensor. Contact Epson for help as described on page 168. *<em>Warning:</em> Except as specifically explained in this <em>User’s Guide</em>, do not attempt to service this product yourself.</td>
</tr>
<tr>
<td><img src="image" alt="Light" /></td>
<td>Flashing orange</td>
<td>It’s time to replace the lamp. See page 148 for instructions. If you continue to use the lamp after the replacement warning, there is an increased possibility that the lamp may break.</td>
</tr>
<tr>
<td><img src="image" alt="Light" /></td>
<td>Flashing red</td>
<td>The lamp may be burnt out. First make sure the lamp cover is securely installed. If that’s not the problem, let the lamp cool, remove the lamp, and replace it as described on page 148. The air filter or vent may be clogged. Clean them or replace the air filter as described on page 147. If this does not resolve the problem, contact Epson as described on page 168.</td>
</tr>
<tr>
<td><img src="image" alt="Light" /></td>
<td>Flashing red</td>
<td>Power is cut off because of an internal problem. Unplug the power cord and contact Epson for help, as described on page 168.</td>
</tr>
</tbody>
</table>
**Viewing Lamp Usage and Other Information**

Use the Info menu to view information about the display settings of your computer and the number of hours the lamp has been used.

Press the **Menu** button and highlight the **Info** menu.

You see the lamp usage hours and various input signal settings on the right.

The life span of the lamp is about 2000 hours if the **Brightness Control** setting in the Setting menu is set to **High** (default), and 3000 hours if the **Brightness Control** setting is set to **Low**. Make sure you have a spare lamp handy if the usage hours on this menu are close to the life span of your lamp.

---

**Solving Projector Operation Problems**

**The power doesn’t turn on.**

- If the projector doesn’t turn on when you press the **Power** button, make sure the power cable is connected to the projector and plugged into a working electrical outlet.

- The power cable may be defective. Disconnect the cable from the outlet and contact Epson as described on page 168.

- Check to see if the A/V Mute Slide is closed.

**The buttons on the projector don’t work.**

If the Operation Lock function has been enabled, you can’t use the buttons on the projector. Try using the remote control instead. See page 126 for information about the Operation Lock function.

**You hear the projector’s fan after the power has been turned off.**

If **Standby Mode** is set to **Network On**, the fans continue to operate after the projector has cooled down. See page 128 for more information about this setting.
Solving Problems with the Image or Sound

No image appears on the screen.

- Check that the Power light is green, not flashing.
- The projector may be in standby or sleep mode. If the Power light is orange, press the \( \mathbb{O} \) Power button to turn the projector on.
- If the power was switched off and then on again, the projector may be cooling down. Wait until the Power light stops flashing and remains orange; then press the \( \mathbb{O} \) Power button again.
- Press the A/V Mute button on the remote control to make sure the picture has not been turned off temporarily.
- Open the A/V Mute Slide, if it is closed.
- The attached computer may be in sleep mode or displaying a black screen saver. Try pressing a key on the computer.
- If you are projecting from a DVD player or other video source, make sure you turn it on and press its Play button.

You’ve connected a computer and see a blue screen with the message No Signal displayed.

- Make sure the cables are connected correctly, as described on page 36.
- Try restarting your computer.
- If you’ve connected a computer and one or more video sources, you may need to press the Source Search button on the projector or one of the source buttons on the remote control to select the correct source. Allow a few seconds for the projector to sync up after pressing the button.
If you’re using a PC notebook:

■ Hold down the **Fn** key on the keyboard and press the function key that lets you display on an external monitor. It may have an icon such as ![external monitor icon], or it may be labelled **CRT/LCD**. Allow a few seconds for the projector to sync up after pressing it. Check your notebook’s manual or online help for details.

On most systems, the **CRT/LCD** key lets you toggle between the LCD screen and the projector, or display on both at the same time.

■ Depending on your computer’s video card, you might need to use the Display utility in the Control Panel to make sure that both the LCD screen and external monitor port are enabled. See your computer’s documentation or online help for details.

If you’re using Mac OS X:

1. Open **System Preferences**.
2. Click **Displays**.
3. Click **Detect Displays**.
4. Make sure the **VGA Display** or **Color LCD** dialog box is selected.
5. Click the **Arrangement** or **Arrange** tab.
6. Make sure the **Mirror Displays** checkbox is selected.

**The message Not Supported is displayed.**

■ Make sure the correct input signal is selected in the Signal menu (see page 118).

■ Make sure your computer’s resolution doesn’t exceed UXGA (1600 × 1200) and the frequency or refresh rate is supported by the projector (see page 179). If necessary, change your computer’s resolution setting as described below.

**Only part of the computer image is displayed.**

■ Press the **Auto** button on the remote control.

■ Make sure the image **Position** setting is correct in the Signal menu. See page 119 for more information.
Press the **Resize** button on the remote control.

Press the **Esc** button on the remote control to cancel the E-Zoom function.

Make sure your computer’s resolution setting is correct. Ideally, it should be 1024 x 768 to match the projector’s native resolution. If this option isn’t available, select one of the other compatible video formats listed on page 179.

**Windows:**
Right-click the desktop, select **Properties**, click the **Settings** tab, and select a different resolution.

**Mac OS X:**
Open **System Preferences**, click **Displays**, and select a different resolution.

You also may need to modify existing presentation files if you created them for a different resolution. See your software documentation for specific information.

**The image isn’t square, but keystone-shaped.**

- If the top or bottom of the image is broader, press the ⬅️ or ➩ button on the projector until the image is square.

- If the projector is angled toward the screen from the left or right, the image will be broader on one side. Center the projector in front of the middle of the screen, facing the screen squarely.

- Enable the Auto Keystone feature to automatically fix the shape. See page 120.

**The image contains static or noise.**

- If you’re using a computer cable longer than 6 feet, or an extension cable, the image quality may be reduced.

- Keep your computer and video cables away from the power cord as much as possible to prevent interference.
- The video signal may be split between the computer and the projector. If you notice a decline in the projected image quality when the image is displayed simultaneously on your notebook computer and the projector, turn off the notebook’s LCD display.

- Make sure the correct input signal is selected in the Signal menu (see page 119).

**The image is blurry.**

- There may be dirt or smears on the lens. Clean the lens as described on page 146.

- Adjust the focus using the focus ring (see page 23).

- Make sure the lens is not fogged by condensation. You may need to wait before using the projector after moving it from a cold environment to a warm environment.

- Adjust the Sharpness setting on the Image menu (see page 117). When you change video settings, you should be able to see the effect on the screen immediately. If you're projecting from a computer, you may also need to adjust the tracking and sync as described in the next section. If you don’t like the new settings, you can always select **Reset** to return to the factory default settings.

**You see vertical bands or the image still looks blurry after trying the solutions in the previous section.**

- If you’re projecting from a computer and displaying an image that contains a lot of fine detail, you may notice vertical bands or some of the characters may look heavy or blurred. Press the **Auto** button on the remote control to reset the projector’s tracking and sync settings.

- If further adjustment is needed, you can fine-tune the **Tracking** and **Sync** settings manually using the Signal menu, as described on page 119.

  1. Fill the screen with an image containing fine detail, such as a pattern to appear as your desktop background, or try projecting black text on a white background.
2. Adjust the Tracking to eliminate vertical bands.

3. Adjust the Sync setting to increase the image sharpness.

The image is too light or dark, or colors are incorrect.

- If you’re displaying a computer image, use the Color Mode option in the projector’s Image menu to adjust the color (see page 116).
- If you’re displaying video, adjust the Color Adjustment and Color Mode settings on the Image menu. You can also try adjusting the Color Saturation, ABS Color Temp, and Tint settings on the Image menu.
- Try adjusting the Brightness and Contrast settings on the Image menu.
- Check your computer display settings to correct the color balance.
- The projector’s lamp may need to be replaced. See page 148 for instructions.

There is no sound, or the sound is not loud enough.

- Press the button on the projector or remote control to increase the volume.
- Make sure A/V Mute is not enabled. (The A/V Mute button may have been pressed.)
- Make sure the A/V Mute Slide is open.
- Try adjusting the Volume setting in the Setting menu (see page 120).

- If you’re using a VCR or other video source, make sure the volume is not turned all the way down or muted. Also, make sure the cables are connected correctly, as described on page 45.

- If your presentation includes computer audio, make sure the volume control on your computer is not turned all the way down or muted. If you’re using the audio cable, make sure it is securely connected to both the projector and your computer’s headphone jack or audio out jack.

- Make sure the Windows volume controls on your computer are not turned all the way down or set to Mute. You may be able to check this by clicking the volume control in your Windows system tray (lower right corner of the screen).

- Make sure the Mac volume controls are not turned all the way down. You may be able to adjust the volume from your menu bar (top right corner of the screen) or via the volume control function keys.

- If you are using external speakers, you need to set the EasyMP Audio Out option to External. When this setting is enabled, you can’t use the buttons on the projector or remote to control the volume. See page 46 or page 121 for more information.

---

**Solving Network Problems**

**You don’t see your projector in the EMP Monitor window.**

- Make sure that you’ve connected the projector to the network and configured it correctly; see page 50. Also, make sure you’ve registered the projector with EMP Monitor; see page 132.

- Make sure that Standby Mode in the projector’s Extended menu is set to Network ON.

- If the computer you are using is running Windows XP or 2000, you must be logged in as the Administrator.
Try restarting your computer.

You can’t connect to the projector using NS Connection.

- Make sure the Epson 802.11g card is installed correctly in the projector; see page 48. If you have to reinstall the card, restart NS Connection or the program will not be able to detect the projector.

- Restart your computer.

- Make sure your projector and computer are configured correctly; see page 51 (Ad Hoc mode) or page 57 (Access Point mode).

- Make sure that you have sufficient wireless signal strength (above 50 percent). On a Mac, check the AirPort icon on the Mac menu bar. In Windows, see the documentation for your computer’s wireless card or adapter for details.

- Make sure you aren’t projecting one of the EasyMP configuration screens. (You should see a message that the projector is ready to connect.) If you have to exit a configuration screen, restart NS Connection.

- If the projector is configured for Access Point mode and you’re using DHCP, allow time for your projector to appear. It takes the server a little while to pick up the IP address.

- If you’ve changed any settings for your projector or network, or restarted your computer, allow a minute or two for the connection to appear. If you’re using AirPort, try turning AirPort off and then on again.

- Make sure that you’re trying to connect to the right network. In Windows, verify that you’ve enabled your computer’s connection to the access point (see page 63) or that your wireless card or adapter is enabled and its SSID is set to match the projector’s ESSID (see page 55). On a Mac, click the AirPort icon at the top of your Mac desktop to make sure AirPort is turned on and the projector’s ESSID or your AirPort network is selected.
■ If you have an access point or AirPort base station and you’re not using DHCP, check your projector’s IP address on the Access Point mode advanced settings screen. The first three segments of the IP address should be identical to the first three segments of the IP address of your access point or base station. The last segment of the projector’s IP address should be close, but not identical, to the last segment of the IP address of the access point or base station.

■ If you’re not using DHCP, check your projector’s Gateway address on the projector’s Access Point mode advanced settings screen. It should be identical to the IP address for your access point or AirPort base station.

■ If you’re using a projector keyword, it changes each time you turn the projector off and then on again, or remove and reinsert the 802.11g wireless card. Check the projector’s keyword on the EasyMP Network screen and enter it at the prompt.

■ If you’re using AirPort, check the configuration of your network. Start the AirPort Admin utility, select your base station, click Configure and click Show All Settings. Click the Network tab. If you set up your projector to connect in DHCP mode, turn on Distribute IP Addresses and Share a Single IP Address.

■ If you’re using AirPort and DHCP is turned off on your projector’s Access Point mode advanced settings screen, make sure Distribute IP Addresses is off.

■ If you’re using Access Point mode and you’re connecting to the wrong network, you may be experiencing signal interference from another network. Try resetting your access point or base station, then restart NS Connection.

■ If you’re using AirPort, the projector’s ESSID should match the AirPort network name, not the name of the AirPort base station. To check the network name, start the AirPort Admin utility, select your base station, and click Configure. Then click Show All Settings. The network name appears on the AirPort tab.

■ If you’re prompted for a password when you connect, enter the WEP encryption key (if you’re using WEP encryption).

■ Try connecting using IP Connect Mode; see page 77.
Solving EasyMP Problems

An image displayed with EasyMP appears distorted.
Because of their resolution, some JPEG images cannot be displayed correctly. Some JPEG files from digital cameras cannot be previewed. Files with a high compression ratio may appear blurry.

In EMP SlideMaker 2, PowerPoint files don't appear in the file window.
EMP SlideMaker 2 does not support PowerPoint 95 or 97. Files created in these versions of PowerPoint must be opened and resaved in PowerPoint 2000 or later.

In EMP SlideMaker 2, your PowerPoint files don't display thumbnails and can't be pasted into scenarios.
Make sure the MS Office JPEG converter has been installed. Run the Office installer, display the Converters and Filters option, and install the JPEG filter. Also, make sure PowerPoint is installed on the computer you’re using to build the scenario.

You can't edit scenario files in EMP SlideMaker after they have been transferred to the USB drive.
You can only edit scenarios before they are transferred. Open the scenario files saved on your hard drive, make any changes, then transfer the scenario to your USB drive.

You can’t transfer your slideshow to the drive because you aren’t able to see the drive letter.
You must connect the drive to your computer before you select Send Scenario from the Scenario Option(s) menu. If this happens, close and restart EMP SlideMaker 2. Make sure your drive is connected before you select Send Scenario.
You can’t play your movies on the projector.

- The projector only supports MPEG2 files. It does not support MPEG1 files.
- Movie files included in a PowerPoint presentation can’t be played back in a scenario.

EasyMP is unable to see the image files on your camera or external drive.

Make sure your camera or drive shows up on your desktop as a drive letter when you connect it to your computer. If it does, it is probably a USB-mounted device and will work with your projector. The projector does not support TWAIN-compliant digital cameras.

Solving Problems with the Remote Control

The projector doesn’t respond to remote control commands.

- The remote control’s batteries may not be installed correctly or may be low on power. To change the batteries, see page 28.
- Make sure you are within about 20 feet (6 meters) of the projector and within range of the projector’s front or back sensor (approximately 30° to the left or right and 15° above or below).
- Dim the room lights and turn off any fluorescent lights. Make sure the projector is not in direct sunlight. Strong lighting, especially fluorescent lights, may affect the projector’s infrared receivers. Also, turn off any nearby equipment that emits infrared energy, such as a radiant room heater.
- If any buttons are held for longer than 30 seconds, the remote enters sleep mode. Release any button that is held to wake the remote.
Where To Get Help

Epson provides these technical support services:

**Internet Support**

Visit Epson’s support website at [www.epson.com/support](http://www.epson.com/support) and select your product for solutions to common problems. You can download utilities and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.

Visit [http://www.presentersonline.com](http://www.presentersonline.com) to access tips, templates, and training for developing successful presentations.

**Speak to a Support Representative**

To use the Epson PrivateLine Support service, call (800) 637-7661 and enter the PIN on the included Epson PrivateLine Support card. This is the fastest way of speaking to a live representative, and it’s free. This service is available 6 AM to 6 PM, Pacific Time, Monday through Friday, for the duration of your warranty period.

You may also speak with a projector support specialist by dialing one of these numbers:

- U.S.: (562) 276-4394, 6 AM to 6 PM, Pacific Time, Monday through Friday.
- Canada: (905) 709-3839, 6 AM to 6 PM, Pacific Time, Monday through Friday.

Days and hours of support are subject to change without notice. Toll or long distance charges may apply.

Before you call for support, please have the following information ready:

- Product name (PowerLite 1705c or 1715c)
- Product serial number (located on the projector)
- Proof of purchase (such as a store receipt) and date of purchase
- Computer or video configuration
- Description of the problem
Purchase Supplies and Accessories

You can purchase screens, carrying cases, or other accessories from an Epson authorized reseller. To find the nearest reseller, call 800-GO-EPSON (800-463-7766). Or you can purchase online at www.epsonstore.com (U.S. sales) or www.epson.ca (Canadian sales).
A

Software Installation

The EasyMP software CD-ROM includes the software you need to use the projector’s EasyMP features—for presenting over a wireless network, transferring PowerPoint presentations to a memory card, and monitoring the projector from a remote location. Epson Projector Software CD-ROM includes EMP Monitor and EMP Network Manager for presenting and monitoring the projector from a remote location.

Windows System Requirements

Before you install the software, make sure your computer meets these requirements:

- Microsoft Windows 2000 (SP4) or Windows XP
- 802.11g or 802.11b, or 802.11a network card or wireless adapter (to use EMP NS Connection wirelessly)
- IBM® compatible PC with at least a Pentium® III 1.2 GHz processor
- At least 256MB of RAM (512 recommended)
- At least 128MB of free hard disk space
- XGA (1024 × 768) or better display adapter and monitor, 16-bit color or higher

note
You can present over a wireless network from Mac OS X, but you can only monitor the projector from a remote location using a Windows system.

Although EMP Slidemaker and EMP Monitor work in Windows 98 and Me, EMP NS Connection requires Windows 2000 or XP.
Mac System Requirements

Before you install the software, make sure your Mac meets the following requirements:

- Mac OS X 10.3 or later (OS X 10.3.9 or 10.4.5 or later recommended)
- AirPort (802.11b) or AirPort Extreme (802.11g) wireless network interface to use EMP NS Connection wirelessly
- Power Macintosh® series G3 900 MHz or more, iMac®, PowerBook®, or iBook®
- At least 256MB of RAM
- At least 128MB of free hard disk space
- XGA (1024 × 768) or better display adapter and monitor, 16-bit color or higher

Installing the Software on a Windows System

Follow these steps:

1. Insert the EasyMP CD-ROM in your computer’s CD-ROM or DVD drive.
2. Click Install, then follow the on-screen instructions to install your projector software.
3. When you see the Virtual Display screen, check each display you want to use. These correspond to the projectors you plan to connect to the computer.

After you install the software, you can change your Virtual Display selection by accessing EPSON Projector from the Start menu and selecting Add-Remove EPSON Virtual Display.
If you see a message that the Epson Projector Support Driver has not passed Windows Logo testing, click **Continue Anyway**. If you have selected multiple Virtual Displays, you will see this message several times.

4. When installation is complete, close the installation window.

**Installing the Software on a Mac**

Follow these steps to install EMP NS Connection:

1. Insert the EasyMP software CD-ROM in your drive.
2. If necessary, double-click the **Epson** CD-ROM icon to open its window.
3. Double-click the **Installer for Mac OS X** icon.
4. Click **Install**, then follow the on-screen instructions to install the software.
5. When installation is complete, close the installation window.
This appendix provides guidelines on installing the projector in a permanent location, such as a theater or conference room.

The projector can be installed for four different viewing setups: front projection, ceiling projection, rear projection onto a semi-transparent screen, or rear/ceiling projection, as shown:

To project from overhead, you’ll need the optional ceiling mounting hardware; see page 13 for ordering information. You’ll also need to select Front/Ceiling or Rear/Ceiling as the Projection option in the projector’s Extended menu to flip the image upside-down. To project from the rear, onto a semi-transparent screen, select Rear or Rear/Ceiling (see page 127).
If you’re mounting the projector on the ceiling and you place it above screen level, you’ll have to tilt the projector down to position the image on the screen. This causes the image to lose its square shape. You can correct the distortion using the Keystone function in the projector’s menu system (see page 120).

If you place the projector so that the base of the lens is level with the bottom of the screen, the image should be square and you won’t have to adjust it. If you place the lens lower than the bottom of the screen, you’ll have to tilt the projector upward if you want to fill the whole screen with the image.
Technical Specifications

**General**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of display</td>
<td>Epson poly-silicon TFT active matrix</td>
</tr>
<tr>
<td>Resolution (native format)</td>
<td>1024 × 768 pixels (XGA)</td>
</tr>
<tr>
<td>Color reproduction</td>
<td>16.8 million colors</td>
</tr>
<tr>
<td>Brightness</td>
<td>1705c: 2200 lumens (High Brightness mode)</td>
</tr>
<tr>
<td></td>
<td>1700 lumens (Low Brightness mode)</td>
</tr>
<tr>
<td></td>
<td>1715c: 2700 lumens (High Brightness mode)</td>
</tr>
<tr>
<td></td>
<td>2100 lumens (Low Brightness mode)</td>
</tr>
<tr>
<td>Contrast ratio</td>
<td>400:1</td>
</tr>
<tr>
<td>Image size</td>
<td>30 to 300 inches</td>
</tr>
<tr>
<td>Projection distance</td>
<td>3.2 to 39.7 feet (1.0 to 12.1 meters)</td>
</tr>
<tr>
<td>Projection methods</td>
<td>Front, rear, upside-down (ceiling mount)</td>
</tr>
<tr>
<td>Internal sound system</td>
<td>1 W monaural</td>
</tr>
<tr>
<td>Optical aspect ratio</td>
<td>4:3 (horizontal:vertical)</td>
</tr>
<tr>
<td>Zoom ratio</td>
<td>1:1.2</td>
</tr>
<tr>
<td>Noise level</td>
<td>35 dB in Low Brightness mode, 40 dB in High Brightness mode</td>
</tr>
<tr>
<td>Keystone correction</td>
<td>Automatic (manual adjustment capability ±30° vertical keystone correction)</td>
</tr>
<tr>
<td>Mouse compatibility</td>
<td>Supports USB (type B)</td>
</tr>
</tbody>
</table>
### Projection Lamp

- **Type**: UHE (Ultra High Efficiency)
- **Power consumption**: 170 W
- **Lamp life**:
  - Approx. 2000 hours (High Brightness mode)
  - Approx. 3000 hours (Low Brightness mode)
- **Part number**: V13H010L38

### Remote Control

- **Range**: 20 feet (6 meters)
- **Batteries (2)**: Alkaline AAA

### Dimensions

- **Height**: 2.7 inches (68 mm), feet retracted
- **Width**: 10.7 inches (273 mm)
- **Depth**: 7.6 inches (193 mm)
- **Weight**: 3.7 lb (1.7 kg)

### Electrical

- **Rated frequency**: 50/60 Hz AC
- **Power supply**: 100 to 120 VAC, 2.7 A
  - 200 to 240 VAC, 1.2 A
- **Power consumption**:
  - Operating:
    - 100 to 120 VAC, 244 W
    - 200 to 240 VAC, 228 W
  - Standby:
    - 100 to 120 VAC, 3.8 W (network off)
    - 18 W (network on)
    - 200 to 240 VAC, 5.1 W (network off)
    - 18 W (network on)

---

**note**

Lamp life results will vary depending upon mode selected, environmental conditions, and usage.

Turn off this product when not in use to prolong the life of the projector.
### Environmental

**Temperature**
Operating: 41 to 95 °F (5 to 35 °C)  
Storage: 14 to 140 °F (−10 to 60 °C)

**Humidity**  
(non-condensing)  
Operating: 20 to 80% RH  
Storage: 10 to 90% RH

**Operating altitude**  
0 to 7,500 ft (0 to 2,286 m)

### Safety

**United States**  
FCC 47CFR Part 15B Class B (DoC)  
UL60950 Third Edition

**Canada**  
ICES-003 Class B  
CSA C22.2 No. 60950

**CE Marking**  
Directive 73/23/EEC  
Directive 89/336/EEC  
IEC 60950 Third Edition  
EN 55022, EN 55024

Pixelworks™ DNX™ ICs are used in this projector.

### Compatible Video Formats

The projector supports NTSC, PAL, and SECAM international video standards, as well as the monitor display formats listed below.

To project images output from a computer, the computer’s video card must be set at a refresh rate (vertical frequency) that’s compatible with the projector. Some images are automatically resized to display in the projector’s “native” format (XGA). The frequencies of some computers may not allow images to display correctly; see your computer’s documentation for details.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Refresh Rate (Hz)</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>VGA EGA</td>
<td>70</td>
<td>640 × 350*</td>
</tr>
<tr>
<td>Mode</td>
<td>Refresh Rate (Hz)</td>
<td>Resolution</td>
</tr>
<tr>
<td>----------</td>
<td>-------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>VGA—60</td>
<td>60</td>
<td>640 × 480*</td>
</tr>
<tr>
<td>VESA—72</td>
<td>72</td>
<td>640 × 480*</td>
</tr>
<tr>
<td>VESA—75</td>
<td>75</td>
<td>640 × 480*</td>
</tr>
<tr>
<td>VESA—85</td>
<td>85</td>
<td>640 × 480*</td>
</tr>
<tr>
<td>SVGA—56</td>
<td>56</td>
<td>800 × 600*</td>
</tr>
<tr>
<td>SVGA—60</td>
<td>60</td>
<td>800 × 600*</td>
</tr>
<tr>
<td>SVGA—72</td>
<td>72</td>
<td>800 × 600*</td>
</tr>
<tr>
<td>SVGA—75</td>
<td>75</td>
<td>800 × 600*</td>
</tr>
<tr>
<td>SVGA—85</td>
<td>85</td>
<td>800 × 600*</td>
</tr>
<tr>
<td>XGA—60</td>
<td>60</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>XGA—70</td>
<td>70</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>XGA—75</td>
<td>75</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>XGA—85</td>
<td>85</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>SXGA1—70</td>
<td>70</td>
<td>1152 × 864*</td>
</tr>
<tr>
<td>SXGA1—75</td>
<td>75</td>
<td>1152 × 864*</td>
</tr>
<tr>
<td>SXGA1—85</td>
<td>85</td>
<td>1152 × 864*</td>
</tr>
<tr>
<td>SXGA2—60</td>
<td>60</td>
<td>1280 × 960*</td>
</tr>
<tr>
<td>SXGA2—75</td>
<td>75</td>
<td>1280 × 960*</td>
</tr>
<tr>
<td>SXGA2—85</td>
<td>85</td>
<td>1280 × 960*</td>
</tr>
<tr>
<td>SXGA+60</td>
<td>60</td>
<td>1400 × 1050*</td>
</tr>
<tr>
<td>SXGA+75</td>
<td>75</td>
<td>1400 × 1050*</td>
</tr>
<tr>
<td>SXGA+85</td>
<td>85</td>
<td>1400 × 1050*</td>
</tr>
<tr>
<td>SXGA3—60</td>
<td>60</td>
<td>1280 × 1024*</td>
</tr>
<tr>
<td>SXGA3—75</td>
<td>75</td>
<td>1280 × 1024*</td>
</tr>
<tr>
<td>SXGA3—85</td>
<td>85</td>
<td>1280 × 1024*</td>
</tr>
<tr>
<td>UXGA—60</td>
<td>60</td>
<td>1600 × 1200*</td>
</tr>
<tr>
<td>iMAC VGA</td>
<td>117</td>
<td>640 × 480*</td>
</tr>
<tr>
<td>iMAC SVGA</td>
<td>95</td>
<td>800 × 600*</td>
</tr>
<tr>
<td>iMAC XGA</td>
<td>75</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>MAC13</td>
<td>67</td>
<td>640 × 480*</td>
</tr>
<tr>
<td>MAC16</td>
<td>75</td>
<td>832 × 624*</td>
</tr>
<tr>
<td>MAC19</td>
<td>75</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>MAC19-60</td>
<td>59</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>MAC21</td>
<td>75</td>
<td>1152 × 870*</td>
</tr>
<tr>
<td>NTSC</td>
<td>60</td>
<td>—</td>
</tr>
<tr>
<td>NTSC 4:43</td>
<td>60</td>
<td>—</td>
</tr>
<tr>
<td>PAL</td>
<td>50</td>
<td>—</td>
</tr>
<tr>
<td>N-PAL</td>
<td>50</td>
<td>—</td>
</tr>
<tr>
<td>M-PAL</td>
<td>60</td>
<td>—</td>
</tr>
<tr>
<td>PAL—60</td>
<td>60</td>
<td>—</td>
</tr>
<tr>
<td>SECAM</td>
<td>50</td>
<td>—</td>
</tr>
<tr>
<td>Mode</td>
<td>Refresh Rate (Hz)</td>
<td>Resolution</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------</td>
<td>------------</td>
</tr>
<tr>
<td>HDTV (720p)</td>
<td>60</td>
<td>—</td>
</tr>
<tr>
<td>HDTV (720p)</td>
<td>50</td>
<td>—</td>
</tr>
<tr>
<td>HDTV (1080i)</td>
<td>60</td>
<td>—</td>
</tr>
<tr>
<td>HDTV (1080i)</td>
<td>50</td>
<td>—</td>
</tr>
<tr>
<td>TV480i</td>
<td>60</td>
<td>—</td>
</tr>
<tr>
<td>TV480i</td>
<td>50</td>
<td>—</td>
</tr>
<tr>
<td>SDTV (480p)</td>
<td>60</td>
<td>—</td>
</tr>
<tr>
<td>SDTV (480p)</td>
<td>50</td>
<td>—</td>
</tr>
</tbody>
</table>

*The image is resized using Epson’s SizeWise™ Technology.
This appendix includes safety instructions and other important information about your Epson PowerLite projector.

**Important Safety Instructions**

Follow these safety instructions when setting up and using the projector:

- Do not place the projector on an unstable cart, stand, or table.
- Do not use the projector near water or sources of heat.
- Use the type of power source indicated on the projector. If you are not sure of the power available, consult your dealer or power company.
- Place the projector near a wall outlet where the plug can be easily unplugged.
- Do not hold the plug with wet hands.
- Take the following precautions for the plug. Failure to comply with these precautions could result in sparks or fire: Do not insert the plug into an outlet with dust present. Insert the plug firmly into the outlet.
- Do not overload wall outlets, extension cords, or integral convenience receptacles. This can cause fire or electric shock.
- Do not place the projector where the cord can be walked on. This may result in fraying or damage to the plug.
- Unplug the projector from the wall outlet before cleaning. Use a damp cloth for cleaning. Do not use liquid or aerosol cleaners.
- Do not block the slots and openings in the projector case. They provide ventilation and prevent the projector from overheating. Do not operate the projector on a sofa, rug, or other soft surface, or in a closed-in cabinet unless proper ventilation is provided.
- Never push objects of any kind through the cabinet slots. Never spill liquid of any kind into the projector.
Except as specifically explained in this User’s Guide, do not attempt to service this product yourself. Refer all servicing to qualified personnel. Opening or removing covers may expose you to dangerous voltages and other hazards.

Unplug the projector from the wall outlet and refer servicing to qualified service personnel under the following conditions: When the power cord or plug is damaged or frayed. If liquid has been spilled into the projector, or if it has been exposed to rain or water. If it does not operate normally when you follow the operating instructions, or if it exhibits a distinct change in performance, indicating a need for service. If it has been dropped or the housing has been damaged.

The lamp(s) in this product contain mercury. Please consult your state and local regulations regarding disposal or recycling. Do not put in the trash.

Unplug the projector during lightning storms or when it will not be used for extended periods.

Do not place the projector and/or remote control on top of heat-producing equipment or in a hot location.

If you use the projector in a country other than where you purchased it, use the correct power cord for that country.

Do not stand on the projector or place heavy objects on it.

Do not use the projector outside of the required temperature range of 41 to 95 °F (5 to 35 °C). Doing so may cause an unstable display and could lead to projector damage.

Do not store the projector outside of the required temperature range of 14 to 140 °F (–10 to 60 °C) or in direct sunlight for long periods of time. Doing so may cause damage to the case.

WARNING: The cords included with this product contain chemicals, including lead, known to the State of California to cause birth defects or other reproductive harm. Wash hands after handling. (Provided in accordance with Proposition 65 in Cal. Health & Safety Code §25249.5 et seq.)
**Remote Control Information**

You can operate the projector by remote control via a line-of-sight infrared (IR) receiver at the front and rear of the projector. The projector may not respond to remote control commands under the following conditions:

- There is an object between the remote control IR emitter and the IR receiver on the projector.
- Ambient light is too bright.
- Certain types of fluorescent lighting are used.
- A strong light source shines into the IR receiver.
- Other equipment that emits infrared energy, such as a radiant room heater, is in the room.

These conditions commonly cause problems for most infrared-controlled equipment. Try the following:

- The remote control’s batteries may be low on power; replace them.
- Dim the ambient lighting and/or turn off any fluorescent lights.
- Close any window coverings and/or move the projector out of direct sunlight.
- Turn off other equipment that emits infrared energy.
Declaration of Conformity

According to 47CFR, Part 2 and 15, Class B Personal Computers and Peripherals; and/or CPU Boards and Power Supplies used with Class B Personal Computers

We: Epson America, Inc.
Located at: 3840 Kilroy Airport Way
            MS: 3-13
            Long Beach, CA 90806-2469
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed, is identical to the representative unit tested and found to be compliant with the standards. Records maintained continue to reflect the equipment being produced can be expected to be within the variation accepted, due to quantity production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Trade Name: Epson
Type of Product: Projector
Model: EMP-1705/1715
Marketing Name: PowerLite 1705c/1715c
**FCC Compliance Statement**

**For United States Users**
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

■ Reorient or relocate the receiving antenna.
■ Increase the separation between the equipment and receiver.
■ Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
■ Consult the dealer or an experienced radio/TV technician for help.

**WARNING**
The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

**For Canadian Users**
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

*Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.*
Warranty

Epson America, Inc. Limited Warranty

Basic Two-Year Warranty and 90-Day Lamp Warranty

What Is Covered: Epson America, Inc. ("Epson") warrants to the original retail purchaser of the Epson product enclosed with this limited warranty statement that the product, if purchased new and operated in the United States or Canada, will be free from defects in workmanship and materials for a period of two (2) years from the date of original purchase (except that the warranty period is 90 days for projector lamps). For warranty service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: If your product requires service, Epson will ask you to bring the product securely packaged in its original container or equivalent, along with proof of the date of original purchase, to your Epson Dealer or Epson Customer Care Center as instructed by Epson. Epson will, at its option, repair or replace the defective unit, without charge for parts or labor. When warranty service involves the exchange of the product or of a part, the item replaced becomes Epson property. The exchanged product or part may be new or previously refurbished to the Epson standard of quality, and at Epson’s option, the replacement may be another model of like kind and quality. Epson’s liability for replacement of the covered product will not exceed the original retail selling price of the covered product. Exchange or replacement products or parts assume the remaining warranty period of the product covered by this limited warranty. However, each replacement lamp carries the limited 90-day warranty stated above.

What This Warranty Does Not Cover: This warranty does not apply to refurbished or reconditioned products. This warranty covers only normal use of the product. 24-hour-per-day or other excessive continual use causes strain and is not considered normal use. This warranty does not cover consumables (e.g., fuses), other than lamps. This warranty is not transferable. Epson is not responsible for warranty service should the Epson label or logo or the rating label or serial number be removed. Epson is not responsible for warranty service should the product fail to be properly maintained or fail to function properly as a result of misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as fire, flood, and lightning, improper electrical current, software problems, interaction with non-Epson products, or service other than by an Epson Authorized Servicer. Postage, insurance, or shipping costs incurred in presenting your Epson product for carry-in warranty service are your responsibility. If a claimed defect cannot be identified or reproduced in service, you will be held responsible for costs incurred.
THE WARRANTY AND REMEDY PROVIDED ABOVE ARE
EXCLUSIVE AND IN LIEU OF ALL OTHER EXPRESS OR IMPLIED
WARRANTIES INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW
THE EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS
APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE
LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE.
UNLESS STATED HEREIN, ANY STATEMENTS OR
REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM
ARE VOID. IN THE EVENT THE REMEDIES ABOVE FAIL, EPSON’S
ENTIRE LIABILITY SHALL BE LIMITED TO A REFUND OF THE
PRICE PAID FOR THE EPSON PRODUCT COVERED BY THIS
LIMITED WARRANTY. EXCEPT AS PROVIDED IN THIS WRITTEN
WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS
AFFILIATES SHALL BE LIABLE FOR ANY LOSS, INCONVENIENCE,
OR DAMAGE, INCLUDING DIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE OR
INABILITY TO USE THE EPSON PRODUCT, WHETHER
RESULTING FROM BREACH OF WARRANTY OR ANY OTHER
LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty
lasts and some jurisdictions do not allow the exclusion or limitation of
incidental or consequential damages, so the above limitations and exclusions
may not apply to you.

This warranty gives you specific legal rights, and you may also have other
rights, which vary from jurisdiction to jurisdiction.

To find the Epson Authorized Reseller nearest you, visit our website at:

To find the Epson Customer Care Center nearest you, visit

You can also call the Epson Connection℠ at (800) 637-7661 + PIN or (562)
276-4394 in the U.S. and (905) 709-3839 in Canada or write to:
Epson America, Inc., P.O. Box 93012, Long Beach, CA 90809-3012.
Index

A
A/V Mute, 25, 30, 126, 158
Access Point mode, 57 to 67
Access point, checking IP address of, 64 to 65
Accessories, 13
Ad Hoc mode, 51 to 56
Adapter, audio, 12, 45
Air filter
  cleaning, 147
  ordering, 13
  replacing, 148 to 150
AirPort, configuring for wireless, 55 to 56, 65 to 67
Altitude, 128, 179
Anti-theft device, 13, 17
Aspect ratio, 177
Audio
  adapter, 12, 45
  connecting equipment, 45 to 46
  controlling volume, 31
  problems, troubleshooting, 162 to 163
  turning off (using A/V Mute), 30
  using with scenarios, 102
Authentication, 70 to 72
Auto button, 25
Auto Setup setting, 119
Autorun setting, 108 to 109

B
Background Color setting, 102
Bands, vertical, 161
Blackboard color mode, 32, 117
Blackboard, projecting on, 32
Blank screen, 20 to 21
Blurry image, 161
bmp, 112
Brightness, 177
Brightness setting, 117

C
Cables
  illustrations, 12
  mouse, 38
  ordering, 13
  remote control cable set, 13
  S-video, 13, 41
  VGA-to-component, 36
Camera, see Digital camera
Capturing image, 124 to 125
Carrying case, 12, 152
Ceiling mount, 13, 175 to 176
Certificate validation, 72
Cleaning
  air filter, 147
  lens, 146
  projector case, 146
CMYK color format, 112
Color
  correcting, 32
  multi-screen adjustment, 129
  problems, 162
  saturation, 117
  settings, 116 to 117
  temperature, 117
Color Mode setting, 116
Component video cable, 13, 39
Composite (RCA) video cable, 39 to 40
Computer
  connecting to, 36 to 39
  correcting images, 25
  selecting source, 19
Connecting projector
  to a computer, 36 to 39
  to a digital camera, 44
  to audio equipment, 45 to 46
  to video equipment, 39 to 43
Continuous play setting, 96, 109
Contrast setting, 117
Customized color mode, 32, 117
<table>
<thead>
<tr>
<th>D</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Data encryption, 79 to 80</td>
<td></td>
</tr>
<tr>
<td>Declaration of Conformity, 186</td>
<td></td>
</tr>
<tr>
<td>Default settings, restoring, 115</td>
<td></td>
</tr>
<tr>
<td>DHCP, 58, 62, 66, 165</td>
<td></td>
</tr>
<tr>
<td>Digital camera</td>
<td></td>
</tr>
<tr>
<td>connecting to, 44</td>
<td></td>
</tr>
<tr>
<td>projecting images from, 97 to 98</td>
<td></td>
</tr>
<tr>
<td>Direct Power On, 26</td>
<td></td>
</tr>
<tr>
<td>Display order setting, 96</td>
<td></td>
</tr>
<tr>
<td>Distance from projector to screen, 16, 177</td>
<td></td>
</tr>
<tr>
<td>Documentation, 10</td>
<td></td>
</tr>
<tr>
<td>DPOF, 112</td>
<td></td>
</tr>
<tr>
<td>Drive, external, 98 to 99</td>
<td></td>
</tr>
<tr>
<td>DVD player, connecting, 39 to 43</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>E</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>EAP authentication, 70 to 72</td>
<td></td>
</tr>
<tr>
<td>EAP-TLS certificate, 72</td>
<td></td>
</tr>
<tr>
<td>EasyMP</td>
<td></td>
</tr>
<tr>
<td>problems, 166 to 167</td>
<td></td>
</tr>
<tr>
<td>software, 171 to 173</td>
<td></td>
</tr>
<tr>
<td>starting, 48, 90</td>
<td></td>
</tr>
<tr>
<td>Electrical specifications, 178</td>
<td></td>
</tr>
<tr>
<td>E-mail alerts, 91 to 92</td>
<td></td>
</tr>
<tr>
<td>EMP Monitor</td>
<td></td>
</tr>
<tr>
<td>changing monitoring interval, 140</td>
<td></td>
</tr>
<tr>
<td>monitoring the projector, 132 to 140</td>
<td></td>
</tr>
<tr>
<td>problems, 163 to 164</td>
<td></td>
</tr>
<tr>
<td>using, 132 to 140</td>
<td></td>
</tr>
<tr>
<td>EMP NS Connection</td>
<td></td>
</tr>
<tr>
<td>configuring projector for, 57 to 72</td>
<td></td>
</tr>
<tr>
<td>creating password for, 50</td>
<td></td>
</tr>
<tr>
<td>disconnecting, 75</td>
<td></td>
</tr>
<tr>
<td>entering keyword, 75</td>
<td></td>
</tr>
<tr>
<td>installing software, 171 to 173</td>
<td></td>
</tr>
<tr>
<td>problems, 164 to 165</td>
<td></td>
</tr>
<tr>
<td>projecting wirelessly, 47 to 83</td>
<td></td>
</tr>
<tr>
<td>using, 73 to 83</td>
<td></td>
</tr>
</tbody>
</table>

| EMP SlideMaker  |
| checking scenarios, 107  |
| converting PowerPoint files, 99 to 100  |
| creating scenarios, 99 to 106  |
| problems, 166 to 167  |
| setting up transitions, 105 to 106  |
| transferring scenarios to drive, 108 to 109  |
| Encryption, 55, 61, 68 to 69, 79 to 80  |
| Environmental specifications, 179  |
| Epson   |
| accessories, 13  |
| presentation tips, 11  |
| PrivateLine Support, 10  |
| technical support, 10, 168 to 169  |
| ESSID, 52, 55, 61, 66, 76, 164  |
| Ethernet unit, optional, 89 to 91  |
| External drive, projecting from, 98 to 99  |
| E-Zoom button, 31  |

<table>
<thead>
<tr>
<th>F</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>FCC compliance statement, 187</td>
<td></td>
</tr>
<tr>
<td>Filter, see Air filter</td>
<td></td>
</tr>
<tr>
<td>Focusing image, 23</td>
<td></td>
</tr>
<tr>
<td>Freeze button, 30</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>G</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Game color mode, 32, 116</td>
<td></td>
</tr>
<tr>
<td>Gateway address, checking, 64</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>H</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>HDTV images, video formats, 181</td>
<td></td>
</tr>
<tr>
<td>Height of image, adjusting, 22</td>
<td></td>
</tr>
<tr>
<td>Help, 168 to 169</td>
<td></td>
</tr>
<tr>
<td>Help system, using, 154</td>
<td></td>
</tr>
<tr>
<td>Help, Epson, 10</td>
<td></td>
</tr>
<tr>
<td>High altitude, 128</td>
<td></td>
</tr>
</tbody>
</table>
Image
- adjusting, 22 to 25, 116 to 117
- blurry, 161
- capturing and saving in projector, 124 to 125
- correcting shape, 23 to 24, 120, 160
- fitting on screen, 119, 159 to 160
- height, adjusting, 22
- problems with, 158 to 162
- projecting on chalkboard, 32
- rotating, 95, 98, 111
- selecting source, 19, 29, 40 to 43
- size and projection distance, 16, 177
- turning off (using A/V Mute), 25, 30
- zooming, 23, 31

Image menu, 116 to 117
Info menu, 157
Infrastructure mode, see Access Point mode
Input signal, selecting, 19, 29, 40 to 43
Installing projector, 175 to 176
Installing software, 171 to 173
IP Connect Mode, 77 to 78

Lamp
- number of hours used, 157
- ordering, 13
- replacing, 148 to 151
- specifications, 178
- status light, 155 to 156
Lamp timer, resetting, 151
Language setting, 128, 154

Laptop computer
- connecting to, 36 to 37
- display problems, 20 to 21, 158 to 159
- selecting source, 19, 29
LEAP authentication, 70 to 72
Lens, cleaning, 146
Lights, status, 155 to 156
Locking projector, 74
Logo, saving on projector, 124 to 126

Mac
- configuring for wireless, 55 to 56, 65 to 67
- display problems, 159
EasyMP system requirements, 172
resolution setting, 160
Manuals, 10
Menus
- changing settings, 114 to 115
- default settings, restoring, 115
- Image, 116 to 117
- Info, 157
- network, 49, 51, 57, 67, 69, 70, 72, 90, 91
- Signal, 118 to 119
- User’s Logo, 124 to 125
Monitoring projector
- e-mail notifications, 91 to 92
- EMP Monitor, 132 to 140
Mouse
- compatibility, 177
- connecting cable for remote, 38 to 39
- using remote control as, 33
Movie files, using in scenarios, 102 to 105
Movie Sending Mode, 83 to 84
MPEG, 83, 112
mpg, 112
mrk, 112
Multi-screen color adjustment, 129
Multi-screen projection, 81 to 83
N
Network
managing projector remotely, 131 to 144
problems, 163 to 165
projecting, 73 to 75
security, 78 to 80
setting, 135
wired, 89 to 91
wireless, 47 to 89
Network card, 171
Network settings, configuring, 48 to 72
New Hardware Wizard, 19
No Signal message, 20, 158 to 159
Noise level, 177
Not Supported message, 159
NS Connection, see EMP NS Connection
Numeric keypad, using, 122

O
Operation Lock setting, 126
Optical aspect ratio, 177
Options for projector, 13

P
Password
protection, 121 to 124
remote access, 50
request code, 124
PC Free, 94 to 99, 110 to 112
PEAP authentication, 70 to 72
Photo color mode, 32, 116
Picture source, selecting, 19, 29, 40 to 43
Picture, see Image
png, 112
Pointer tool, using, 34
Positioning
image, 22
projector, 16 to 17, 175 to 176
Power
button, 19
specifications, 178
status light, 19, 155 to 156
PowerPoint files
adding slides to a scenario, 102 to 104
converting to scenarios, 99 to 100
presenting, 110 to 111
problems, 166
Presentation color mode, 32, 116
Presentation Mode, 85
Presentations
computer, 25, 36 to 39
digital camera, 44, 97 to 98
room conditions, 16, 28
tips and training, 11
using the pointer tool, 34
video, 39 to 43
wireless, 47 to 83
Presenter View, 85 to 88
Presenters Online, 11
PrivateLine Support, 10
Problems
color, 162
connecting wirelessly, 75 to 76, 164 to 165
image, 158 to 162
monitoring projector, 163 to 164
no signal, 20, 158 to 159
remote control, 167
scenarios, 166 to 167
sound, 162 to 163
using on-screen help, 154
Progressive format, 112, 119
Projecting without screen, 32
Projection lamp, see Lamp
Projector
- carrying case, 152
- cleaning, 146
- disabling buttons, 126
- distance from screen, 16, 177
- installing, 175 to 176
- lamp specifications, 178
- locking, 74
- monitoring remotely, 131 to 144
- options, 13
- password protection, 121 to 124
- positioning, 16 to 17
- resolution, 177
- specifications, 177 to 179
- transporting, 152
- troubleshooting, 153 to 156
- turning off, 25 to 26
- turning on, 17 to 19
- unpacking, 12
- viewing information about, 157

R
- Raising image, 22
- Rear-screen projection, 127, 175 to 176
- Registration, 11
- Remote control
  - A/V Mute button, 30
  - as wireless mouse, 33
  - battery used, 178
  - connecting cable for mouse, 38 to 39
  - correcting color, 32
  - E-Zoom button, 31
  - Freeze button, 30
  - information, 185
  - numeric keypad, using, 122
  - pointer tool, using, 34
  - problems, 167, 185
  - range, 178
  - running slideshow with, 110 to 111
  - specifications, 178
  - switching sources, 29
  - troubleshooting, 167
- Removing wireless card, 89
- Replacing lamp, 148 to 151
- Request code, password, 124
- Resetting lamp timer, 151
- Resetting menu options, 115
- Resize image, 32
- Resolution, 32, 159, 177
- Rotating the image, 95, 98, 111

S
- Safety
  - instructions, 183 to 184
  - specifications, 179
- Saturation setting, 117
- Scenarios
  - adding movie files, 102 to 105
  - adding sound, 102
  - background color, 102
  - cells, 104
  - converting PowerPoint files, 99 to 100
  - creating, 99 to 106
  - default location, 102
  - exiting, 95, 111
  - presenting on the projector, 110 to 111
  - previewing, 107
  - problems, 166 to 167
  - rearranging, 104
  - running automatically, 108 to 109
  - transferring to drive, 108 to 109
  - transitions, 105 to 106
- Screen
  - blank, 20 to 21
  - distance from projector, 16, 177
  - ordering, 13
  - startup screen, creating, 124 to 125
- Screen image, See Image
- Screen switching time setting, 97
- Security
  - Kensington lock, 13
  - network, 78 to 80
  - password protection, 121 to 124
- Sharpness setting, 117
- Signal menu, 118 to 119
- sit (presentation file type), 112
- Six-axis color adjustment, 117 to 118
- Sleep mode, 26
SlideMaker, see EMP SlideMaker

Slides
displaying on the fly, 94 to 97

Software installation, 171 to 173

Sound
adding to scenarios, 102
troubleshooting, 162, 163

Source
selecting, 19, 29
viewing, 157

Speaker, specifications, 177
Speakers, connecting, 46

Special effects, adding to slide transitions, 97

Specifications
brightness, 177
dimensions, 178
electrical, 178
environmental, 179
general, 177
lamp, 178
remote control, 178
resolution, 177
safety, 179
Sports color mode, 32, 116
sRGB color mode, 32, 116

Standby Mode setting, 135

Startup screen
user’s logo, See User’s Logo

Startup screen, creating, 124 to 126

Status lights, 155 to 156

Support, see Technical support
S-video cable, 13, 41

Switching picture source, 19, 29
Sync setting, 119

Synchronization, adjusting, 25, 161 to 162

Technical support, 10, 168 to 169

Temperature
requirements, 179
status light, 155 to 156
Temperature, color, 117
Theatre color mode, 32, 116

Thumbnails, scenario, 103

Tint setting, 117

Tracking, adjusting, 25, 161 to 162

Transitions, scenario, 105 to 106

Transporting projector, 152

Troubleshooting
blank screen, 20 to 21, 158 to 159
cut-off image, 159 to 160
distorted image, 23 to 24

EasyMP problems, 166 to 167
image and sound problems, 158 to 163

network problems, 163 to 165

no signal, 20, 158 to 159
projector problems, 153 to 156
remote control problems, 167
wireless projection problems, 75 to 76, 164 to 165

Turning off picture (using A/V Mute), 30
Turning off projector, 25 to 26

Unpacking projector, 12

USB cable, 12, 37, 38

USB display, 37 to 38

USB drive
transferring scenarios to, 108 to 109

User’s Logo menu, 124 to 125

Video

VCR, connecting, 39 to 43

Video
cables, 12, 13, 39
connecting video equipment, 39 to 43
display settings, viewing, 157
formats, supported, 179 to 181
projecting wirelessly, 83 to 84
selecting source, 19, 29, 40, 41

Video Signal setting, 119
Volume, controlling, 31

Warning lights, 155 to 156
Warranty, 11, 188 to 189
WEP encryption, 68 to 69
Windows
   configuring for wireless, 53 to 55, 59 to 63
   display problems, 159
   EasyMP system requirements, 171
   resolution setting, 160
Wired network, 89 to 91
Wireless
   connecting manually, 77 to 78
   EAP, 70 to 72
   EAP-TLS, 72
   LEAP, 70 to 72
   module, 12
   network card, 48, 89, 171
   PEAP, 70 to 72
   presentation, 47 to 83
   problems, 164 to 165
   security, 78 to 80
   WEP encryption, 68 to 69
   WPA security, 69 to 70
Wireless, mouse, 33, 38 to 39
WPA security, 69 to 70

Z

Zoom ratio, 177
Zooming image, 23, 31